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All One Lambda software products are designed to assist personnel experienced in HLA 
analysis by suggesting typing results. However, any clinical or diagnostic results must be 
carefully reviewed by a person qualified in HLA typing to assure correctness. This software may 
be used to aid in suggesting results, but should not be used as the sole method for determining 
reportable results. This software is meant as a laboratory aid, not as a source of definitive 
results. The software design does not mitigate hazards associated with the software. The 
laboratory director or technologist trained in histocompatibility testing is required to review all 
data to detect any problems with the software. 
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Introduction 
 
What is HLA Fusion Research™

 

? 

HLA Fusion Research is a companion to One Lambda’s ConsenSys™, SSO, and Micro SSP™

The features of this software allow you to do the following: 

 products. 
This software runs in both stand-alone, (on a single computer) and in network environments.  

• Import raw data 

• Manually enter reaction patterns 

• Analyze the raw data and review the results in graphical form 

• Easily update product information (new product and lot information) 

• Search for specific data and create standard or custom reports 

• Compare results to One Lambda quality control (QC) data 

 
 

README Files 

 

A README file is provided with each software update. 

This file provides a list of significant changes to the software and also critical information that is not 
included in the user’s manual. 

 
 

Program Updates 

Note: For best results, always make sure you are using the latest version of HLA Fusion™ Research 
software. 

You may obtain updates of HLA Fusion™ Research by request. Please contact your One Lambda, Inc. 
representative for a copy of the software or see the Technical Support section for more contact 
information. Product information updates, (catalog files, etc.) for HLA Fusion™ Research are available 
through your One Lambda Inc. representative, or from the One Lambda website: 

http://download.onelambda.com 

 

http://download.onelambda.com/�
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Limitations of the Program 

 

All One Lambda software products are designed to assist personnel experienced in HLA analysis by 
suggesting typing results. However, results must be carefully reviewed by a person qualified in HLA 
typing to assure correctness.  This software may be used to aid in suggesting results, but should not be 
used as the sole method for determining reportable results. This software is meant as a laboratory aid, 
not as a source of definitive results. 

For the reliability of patient information stored in the database, users must ensure that the identifier 
for each patient is unique and that each sample identifier is unique. 

The storage capability of HLA Fusion™ Research is limited by the Microsoft SQL Server Desktop 
Engine or SQL Server 2008. (The user must manually archive data.) 

HLA Fusion™

 

 Research assumes that data for each required input is in a standard format that has not 
been modified. 

The HLA Fusion™

.ab1 file for ConsenSys 

 Research analyzes a data file in one of the following formats: 

.csv file for SSO 

.csv file for Micro SSP 

The data file name, (also known as a Session ID) can be up to 100 characters long and includes the .csv 
extension. 

The data is generated based on original, unmodified templates provided by One Lambda, Inc. 

The user is responsible for final assignments and must review all suggested results. 

 

 

Technical Support  

For technical support or to report software problems, contact your One Lambda representative. 

From the United States, call 800-822-8824, or from the Greater Los Angeles Area, call 818-702-0042. 

Contact us by e-mail at: techsupport@onelambda.com. 

For system requirements, see the HLA Fusion Research Installation Guide. 
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Scope of This Manual 

 

This manual provides information on how to import raw data and then analyze it, making adjustments 
in cut-off values as necessary. It is very important to recognize that the QC, (Quality Control) data used 
with this program and the defaults set in this program are based on One Lambda’s experience with the 
product in a tightly-controlled research and development environment. Thus, a laboratory performing 
HLA typing in another environment may need to reset cutoff values to meet specific laboratory 
requirements. 

From the Main Menu of HLA Fusion™ Research, you can access the three major components of 
the program: 

• Analyze Data 

• Manage Records 

• Manage Samples 

In addition, you may also access the following features: 

• Patient Information 

• Utilities 

• Help 

This manual helps you start using One Lambda’s HLA Fusion™ Research. It includes an overview of 
the system and then quickly takes you into the process of analyzing data.  

 

See the HLA Fusion Research Installation Guide for installation instructions. 
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Navigation 
This section describes the various ways to access the HLA Fusion™ Research software functions, as 
well as how to use the Navigator tool to access and move between sessions and samples. 

Logging On To Fusion Research 

 

Double-click the HLA Fusion Research icon on your computer desktop. 

 

You can also open the program by clicking Start > All Programs > One Lambda > HLA Fusion 
Research. 

The Security Login dialog box is displayed. 

 

 

 

1. Enter your User Name and Password. 

2. Click the Log In  button to open the program. 

 

 

 

 

Note: The Database field displays the database to which you are currently connected. 

Retrieving a Forgotten User Name or Password 

If you forget your HLA Fusion Research password, click the Forgot Password

 

 link, and answer the two 
security questions you were asked when you set up your user profile. The password is displayed when 
the questions are answered correctly. 
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MMiinniimmuumm  SSccrreeeenn  RReessoolluuttiioonn  

 

 

If you forget your user name, click the Forgot UserName

The system displays the user name matching the data you 
provide. 

 link, 
enter your first and last name, and select your lab role, 
(supervisor or technician). 

 
 
 

 

Key System Settings 

Screen Resolution 

HLA Fusion software requires a screen resolution of 1280 x 960

 

. The software displays a message if 
your current resolution is less than the expected settings. 

 

 

 

 

 

 

Note:  You can choose to suppress this message through the Edit link on the General 
Configurations section of the Home page. 

You can select Yes to have the system attempt to make the adjustment. It will continue to start the 
application even if it could not adjust the resolution. Or, you can select No

In addition, if your computer is running the Microsoft

 and adjust it manually. 
® Windows 7® operating system, the text display 

setting must be set to Smaller - 100% (default)

 

. 
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WWiinnddoowwss  77  SSccrreeeenn  RReessoolluuttiioonn  wwiinnddooww  

Take these steps if you need to adjust the screen text display size: 

 

 

Right-click on the computer desktop. Select the Screen Resolution option. 

 

 

 

 

 

 

The Screen Resolution window displays. 

 

 

Select the Make text and other items larger or 
smaller

 

. 

 

 

1. Select Smaller sized text. 

 

 

 

 

 

 

 

 

 

 

 

 

WWiinnddoowwss  --  sseelleeccttiinngg  ssmmaalllleerr  ssiizzeedd  tteexxtt  
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File Permissions 

 

All HLA Fusion Research users must have read and write permissions to the following directories and 
files: 

• OneLambda.Fusion.Interface.exe.config 

• ReportMap.xml 

• C:\OLI Fusion\ 

…and all the sub directories and the files in these directories. 

 

Character Length 

 

If you are using SQL Server 2000 and encounter a report or results that require more than 8000 
characters of data, you must update to SQL Server 2005. 
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OOppeennss  tthhee  
UUsseerr  LLiisstt  
wwiinnddooww  

OOppeennss  tthhee  
NNaavviiggaattoorr  

SSeeaarrcchh  
CCrriitteerriiaa    

  
TThhee  FFuussiioonn  

EExxpplloorreerr::  cclliicckk  
aannyy  bbuuttttoonn  ttoo  

ooppeenn  tthhee  
ccoorrrreessppoonnddiinngg  

pprroodduucctt  
SSttaattuuss  

  

GGrreeeenn  iiff  
AAuuddiitt  
LLooggggiinngg  iiss  oonn,,  
RReedd  iiff  iitt’’ss  ooffff  

OOppeennss  tthhee  FFuussiioonn  
sseettuupp  wwiinnddooww  ffoorr  
ggeenneerraall,,  pprriinntteerr,,  
UURRLL’’ss  aanndd  ddiirreeccttoorryy  
ppaatthh  sseettuupp..  

OOppeennss    tthhee  
pprriinntteerr  sseettuupp  
wwiinnddooww  

NNoottiiffiiccaattiioonn  tthhaatt  
nneeww  oorr  uuppddaatteedd  
ccaattaallooggss,,  NNMMDDPP  
aanndd  SSeerroollooggyy  
eeqquuiivvaalleenntt  ffiilleess  
aarree  aavvaaiillaabbllee..  

OOppeennss  tthhee  AAnnaallyyssiiss  
PPrroodduucctt  SSeelleeccttiioonn  wwiinnddooww  

OOppeennss    tthhee  
RReeffeerreennccee  FFiillee  

    

OOppeennss    tthhee  CCaattaalloogg  
MMaannaaggeemmeenntt  wwiinnddooww  

User Interface 

Fusion Research Home Pages 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: If the current page does not show updated information upon modification or downloads, go 
back to the main Home page, and then return to the product home page to see the changes. 
This interface is the default when you first log in to HLA Fusion Research, but you can change it. 

 
 
 
 
 
 
On the HLA Fusion Research Menu Bar, click 
Utilities > General Settings and select the 
General Setting tab. 
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TThhee  FFuussiioonn  NNaavviiggaattoorr  

To go to home page for one of the products listed in the bottom left area of the page, (the Fusion 
Research Explorer) click the appropriate button in this area, as in this example for SSO: 
 

 
 

 
Or, click the KIR/SSO button on the Toolbar as shown here. 

 

 
 
Or, click the ConsenSys Home Page button in the Fusion Research Explorer. 
 
 

 

 

You can also click the ConsenSys (aka: SBT)  button which is located on the HLA Fusion Research 
Toolbar at the top of the screen. 

Note: Migrated and upgraded databases also use this same interface. 

The Navigator 

 

If the Navigator tab is not already displayed on the right of the application window, click the Show 
Navigator  toolbar button to activate the Navigator function. 

Otherwise, move your cursor over the Navigator tab on the right border of the application window to 
slide the Navigator into view. 

 

 

 

 

When the top of the Navigator window is Blue, it will remain open 
until you click any button or control, or on various other active areas 
of the main screen. 
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Navigator Tree 

 

Using the Navigator tree, you can easily move between analysis sessions and samples. 

Note: Double click on a session, or click the + sign to the left of the catalog, date or product module 
to display the list of sessions. 
 
 
 
 
 
 
 
 
 
 
 
 

Results Grouping 

The sessions and samples displayed though the Navigator tool can be sorted by various criteria:  

• Product type 

• Catalog (Session Name) 

• Test Date 

• Session Date 

The default is to group by Product. See the next few sections for details about these different display 
options. 

 

Group by Product 

 

The Navigator displays imported sessions for each product type based on the date range and other 
criteria set in the Find option. 

To set or adjust the default search settings for HLA Fusion Research, do the following: 

 

 

1. Click the Find  button on the Fusion Toolbar. 
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NNaavviiggaattoorr::  PPrroodduucctt  LLiisstt  

This will open the Search Criteria screen. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Whatever search settings you set here become the default search settings for HLA Fusion Research. 

So, if you’re already in the analysis mode with a certain product, only the sessions that fit the Find 
Criteria you’ve set for that product will display. 

You can choose to search by Patient ID, Sample ID, Session ID, or Other. 

Other

The Find dialog box also allows you to modify the Navigator session sort and display criteria. 

 allows you to provide multiple search criteria: Test Date range, Session Date range, 
Session status, and Catalog Type. 

Note: The date range set here, in the Session Date field, is used as the default date range 
throughout the software, such as in the Navigator and Reports windows. Each time you change it, 
and click Find, the default changes for the rest of the application. 

 

Group by Catalog 

 

When you select the Catalog option, sessions are displayed in 
alphanumeric order by catalog name. 

Click the  sign next to the product type you’re interested in to display 
its individual sessions. 
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The sessions displayed in blue are the ones that have not yet been 
reviewed.  Once you review a session, its color on the Navigator list 
changes to black. 

Otherwise, the use of this tool is the same as described above in Group 
by Product. 

 
 

Group by Test Date 

 
 

 

When you select the Test Date group option, sessions are displayed in 
chronological order by their test dates. 

 

Otherwise, the use of this tool is the same as described previously in Group 
by Catalog or Group by Product. 

 
 
 
 
 

 

Group by Session Date 

 
 

When you select the Session Date option, sessions are displayed in order 
of their creation dates. 

Click a session name to display the samples within this session and a session 
summary. 

Otherwise, the use of this tool is the same as described above in Group by 
Product, Catalog, or Test Date. 

 

 

If a session sample is listed in red, this means the sample failed in batch 
analysis. 

Click a sample
 

 name to display it in an analysis window. 
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Accessing HLA Fusion Research™

 

 Software Functions 

Main Menu Options 

You can access HLA Fusion Research functionality at any time from the Menu Bar, which is 
displayed at the top of all HLA Fusion Research application windows. 

 

See the following sections for a list of the options available under each main menu item. 

 

Analyze Data 

Each option under this menu item is a molecular product for which you can import CSV files, or 
manually enter reactions and analyze data. 

 

 

 

 

 

 

Any of these analysis programs can also be opened by clicking on their Toolbar Icons or the tiles for 
each program at the bottom left of the screen in the Fusion Explorer. 

For details, see the individual product analysis sections in this user manual. 

Reports 

When you select this menu item, the Reports page is displayed, allowing you to create reports of your 
analysis data. 
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Data 

 

 

 

When you select this menu item, a Data window is displayed that allows you to manage, (delete, 
archive, activate and move) sessions and samples, map session alleles to the new NMDP nomenclature, 
and view/print log files of session data. 

 

Sample 

Options under this menu item pertain to importing, creating, managing, and exporting sample 
information. This is also the menu to use for managing Luminex test lists and for creating sample work 
lists and plate designs. 

 

 

 

 

 

 

 

 

Patient Info 

Options under this menu item pertain to importing patient and/or donor lists, and managing 
individual patient and/or donor information. 
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Profile 

 

 

 

 

 

There are options under this menu item for creating and managing your own user profile, lists of 
system users and privileges, and lab information. 

There is also an option for switching between the home page options, depending on your system 
navigation preferences. 

 

Utilities 

The options under this menu item pertain to importing catalog, code and serology files, configuring the 
molecular and products you analyze, setting up your HLA Fusion Research system, and system 
validation. 

 

 

 

 

 

 

 

 

Help 

This menu item allows you to access the following HLA Fusion Research Software information: 

• Online help, which provides guidance in using HLA Fusion Research Software. 

• Notification of updates and a description of new features in the latest HLA Fusion Research 
software. 

• Dynamically updated Frequently Asked Questions (FAQs) about the HLA Fusion Research 
software. 

• The build and version number of the HLA Fusion Research Software application you are 
currently using. 
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Note: The online help can be accessed from anywhere within the HLA Fusion Research application 
when you press the F1 key. 

Occasionally, updates are made to the online help between releases of the HLA Fusion Research. To 
ensure you have the most current help file, you can either check the OLI download site, 
download.onelambda.com - /pub/tray_info/Windows/HLA_Fusion_Catalogs/Document/, or you 
can enable the auto-download feature from the Fusion Research default home page. 

 

 

 

 

 

 

 

 

Exit 

When you select this menu item, a dialog box displays that allows you either to select 
Yes to exit and close the HLA Fusion Research application, or select No to keep the 
current session open. 

 

Toolbar Buttons 

HLA Fusion Research provides a toolbar, displayed just below the Menu Bar, with access to commonly 
used functions. 

 

• Note that some icons may not be available or enabled unless you’re on an analysis screen. 

• Some icons are only enabled in HLA Fusion Research while other icons are not enabled in the 
research version. 

 

The table on the next page describes each toolbar button. 
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Home Button 

Wherever you are in Fusion, clicking the Home  button 
returns you to the Fusion Home Page. 

 

Find 

Clicking the Find  button opens the Search Screen where you 
can search by Patient ID, Sample ID, Session ID, or  by 
Other criteria.  

The Search Screen also allows you to modify the Navigator 
session sort and display criteria. 

 

Print Report 

From any analysis window, you can click the Print Report 
button to display a list of the reports that you can print.  The 
reports you see listed are specific to the product you are 
currently analyzing. 

If you have set a default printer for your system, (configured 
through Utilities > Printer Setup) the selected report is sent 
directly to the specified printer. 

Otherwise, a dialog box is displayed from which you can select a 
printer. 

 

Preview Report 

From any Analysis Screen, click the Preview Report  button to display a list of reports you can 
investigate before printing.  The reports listed are specific to the product you’re currently analyzing. 

The reports are displayed in a preview window. 

 Use the Print  and Export  buttons in the preview window to output the report in 
the selected format. 

 Click the Close  button at the upper right of the screen to exit the preview window. 

 

Button Name or Function 

 
Home 

 
Find 

 Print Report 

 Preview Report 

 Print Screen 

 Magnify 

 Reports 

 Show Navigator 

 Patient Information 

 Related Records 

 Side-by-Side Analysis 

 
Micro SSP 

 SBT/ConsenSys 

 SSO/KIR 
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Print Screen 

From any Analysis Screen, click the Print Screen  button to open a new window containing a 
screen shot of the entire Fusion screen display.  

Click the Print  button, (top, left corner)to send the screen shot directly to the printer. 

To close this window, click the Exit  button or the Close  button. 

Magnify 

From any analysis window, click the Magnify  button to activate the magnifying glass and enlarge 
any section of the window. 

 

 

 Use the arrow keys on your computer keyboard to 
increase or decrease the height and width of the 
magnified area. 

 Click anywhere on the screen to deactivate the 
magnifying glass. 

 

 

Reports 

From any screen, click the Reports  button on the Fusion Toolbar to open the Reports Screen. 
You can also click the Reports  button located in the Fusion Explorer at the bottom, left of 
the screen. 

 
 
 

 

 

The type of available reports listed will 
depend on the product and nature of 
analysis you’re conducting. 

 

Please see the section on Reports for 
detailed information. 
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PPaattiieenntt//DDoonnoorr  IInnffoorrmmaattiioonn  SSccrreeeenn  

Show Navigator 

Click the Show Navigator  button if the Navigator tab, normally 
displayed on the upper right side of the application window, is not 
visible. 

Once the Navigator tab is displayed, you can move your cursor over it to 
slide the Navigator panel open.  When the top of the Navigator window 
is Blue, it will remain open until you click any button or control, or on 
various other active areas of the main screen. 

 

Patient 

From any analysis window, click the Patient button to display the Patient/Donor Information 
Screen where you can enter or edit information related to a patient or donor and associate it with the 
current sample. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Related Records  

A related record is a sample that is associated in some way with the 
current sample or patient. 
 
From any analysis window, click the Related Records  button to 
load all records related to the current sample into the drop-down list 
in the Sample ID field. Use the sample navigation arrows to display 
the analysis of each related record one-by-one. 
 
To exit from the related records mode, click the <<Summary link 
next to the Sample ID field near the top, center of the screen. 
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Note: This function can also be accessed by right-clicking a sample in the Navigator. See the 
product-specific sections of this manual for more information about using this feature. 

 

Side-by-Side Analysis 

 
From any analysis window, click the Side-by-Side Analysis button to compare the current sample  
analysis with previous analysis sessions for the same Sample ID. 

Select a previous sample analysis from the displayed list to compare to the current one. The two 
analysis windows are then displayed together in a comparison window. 

Each window can be resized and moved by dragging and dropping. Click again on the Side-by-Side 
Analysis button to cancel the comparison display. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Note: This function can also be accessed by right-clicking a sample in the Navigator. 
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Product Data Analysis 
 

Click any of the Product Data Analysis buttons to display the product home page, import a session 
file, manually enter a session, or select from the Navigator list of already imported sessions for that 
product. 

 
 
 
 
 
 

Remember that you can also access any product by clicking on it in the HLA Fusion Explorer at the 
bottom, right of the screen, or by clicking on Analyze Data on the Fusion Menu Bar. 
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Sample Navigation 

The Sample Navigation tools, (only accessible from the analysis windows) give you access to all the 
samples in the current session.  

You can select a different sample within the same session either by selecting from the drop-down list in 
the Sample ID field, or by clicking the forward/back arrow buttons to the right. 

 
 
 
 
 
  
 
 
 

 
 
 

 
 
 
 
 
 

Clicking on the drop-down  arrow displays the samples within the current session. 

Selecting a sample from this list in the Sample ID field makes the selected sample active in the analysis 
window. 

Alternatively, you can use the Forward and Back Arrow  buttons to select different 
samples. 

At the top of the main analysis window, click the word <<Summary to return to the Summary Screen 
for the current session. 
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ConsenSys Analysis 
HLA Fusion™ Research ConsenSys Analysis uses sequence-based typing techniques, (SBT) to analyze 
sequence data and to determine an HLA typing. The software aligns sequence data generated by an 
ABI sequencer with IMGT/HLA data and assigns allele typing based on sequence similarity. The 
software also normalizes the electropherogram (EPG) so peaks are uniform in height, this enables the 
quick and clear detection of polymorphic SNPs and the correct HLA type is automatically identified in 
most cases. Through the sequence navigator, the end user is guided through all sequence mismatches 
which require auditing. Auditing each nucleotide mismatch will refine the final assigned allele typing. 
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Overview: ConsenSys Analysis 

 

HLA Fusion™

To begin a ConsenSys

 Research analysis uses sequence-based-typing techniques, (SBT) to analyze sequence 
data and determine an HLA typing. 

™

Base mismatches or close base calls are flagged by the software and must be resolved by the user. 

 analysis session, you build a session using Sample IDs or Ab1 files. This 
information can be saved as a Plate Record for later use. You can also analyze Ab1 files directly. 

From the Analysis window you can: 

 View the electropherogram, (EPG) results 

 Add sample comments 

 Flag a sample for more testing 

 Accept, edit or audit base calls 

 Compare sequence data against IMGT/HLA reference sequences and the EPG interpretation 
algorithm to automatically assign HLA alleles that match your data. 

 Utilize tools to audit, manually edit, compare, and report HLA allele assignments. 

 Improve SSO results significantly with the combined analysis feature using SBT data. 

Analysis Objectives: 

 Audit all polymorphic bases and confirm all base assignments. 

 Audit and edit all mismatches and heterozygous bases to obtain the best-matched sequences 
for heterozygous alleles. 

 Evaluate and confirm final allele assignments. 

 

Note: Before beginning, make sure you have the most up-to-date serology. On the Fusion Research 
Menu Bar, click Utilities > Update Reference > Update Reference File. Select Update Serology 
Equivalent and click the Import Serology button. Also make sure you have updated the ConsenSys 
reference files. 
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Define the File Naming Convention 

 

With HLA Fusion™

1. On the Fusion Research Menu Bar, click Utilities > Molecular Product Configuration > 
Ab1 Filename Configuration. 

 Research, you can define and specify the file naming rules to be used with 
ConsenSys: 

 

The Ab1 Filename Configuration screen opens: 

 

 

 

 

 

 

 

 

 

 

When defining the Ab1 and Locus file naming configurations, remember that the Sample ID name 
must match between LABType and SBT sessions for combined analysis. 

For example: 

“SampleName_BLocus_2F” 

Or… 

“SampleName_HLA-B_2F” 

Another Example: 

TEF401   in a LABType session  

TEF401_DRB1_2F  in a ConsenSys session 

 

Remember to only use an underscore “_” in sample names.  No spaces or other special characters 
should be used. 

2. As you make changes to the Ab1 file configuration, Fusion 
displays an example of what a Sample ID might look like 
using the new configuration: 

3. Click the Save  button to retain your file naming rule 
selections. 
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Update Serology Equivalent and Catalog files 

 

To analyze SBT data, first make sure that you have the most up to date serology and ConsenSys™

 

 
catalog files. 

To update serology files: 
 

1. Click: Utilities > Update References > Update Reference File 
2. Select the Serology equivalent radio button. 
3. Choose the appropriate Sero_equivalent file from the list on the right side of the screen.  

a. If a serology file does not appear in the window, navigate to it by using the directory tree 
on the left. 

4. Select the appropriate serology file 
5. Click the Import Serology  button. 

 
After successful serology file importation, you should see this 
message: 

 
6. Click the OK  button to close the confirmation message. 
7. Click the Close  button when you’re done. 

 
 
 
To update ConsenSys™

 
 file catalogs: 

1. Go to Utilities > Update References > Update Reference File > 
2. Select the ConsenSys radio button. 
3. If the ConsenSys™ catalog file(s) are not listed, navigate to it by using the directory tree on the 

left. 
4. Select the ConsenSys™ catalog files to import. 
5. Select Import ConsenSys  button. 

 
After the catalog files have been successfully imported you 
should see the following message: 

 
6. Click the OK  button to dismiss the confirmation message. 
7. Click the Close  button when you’re done. 
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CCoonnsseennSSyyss  HHoommee  PPaaggee  

Starting a Combined Analysis Session 

 

Note: If analyzing LabType™ data in combination with ConsenSys™ data, make sure that the database 
linked to HLA Fusion™ Research matches the database used to analyze SSO data in HLA Fusion™

 

. If 
the database names are different you will not be able to link SSO and SBT data. Nomenclature 
updates between SSO and SBT analysis must also match. 

1. Click the ConsenSys home page button… 

 
 
 

…or the ConsenSys Toolbar  button to open the ConsenSys Home Page. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The ConsenSys Home Page displays important information concerning your ConsenSys products and 
reference files, and the Ab1 File Name Format being used. 
 
 

2. Next, click the Manual Entry button located at the top, left 
corner of the screen. 
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When the dialog box for starting a ConsenSys Manual Entry session displays, you’ll notice that Fusion 
has already assigned a session name. 

 The Analysis Session Name: You can rename the session if you prefer. Remember that the 
Session Name must be unique within Fusion Research. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

 The Test Date: You may accept the current Test Date, or select a different test date by 
clicking the Down Arrow  and selecting another date from the pop-up calendar. 

3. You have the choice of creating a new session/tray or open existing sequencing samples. 

To create a New Session/Tray: 

Click the Create New Session/Tray  button. 

A new window is displayed to allow for subsequent session/tray information. 

4. Enter all required information in the fields at the top of the window. 

5. Click the Start Analysis button at the bottom of this screen. 
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The ConsenSys analysis window is displayed. 

Adding an Ab1 File 

1. From the Session/Tray information window, click the Add Ab1 File button at the bottom. The 
file import window is displayed. 

2. Browse to the folder on your computer containing the Ab1 data file(s) you want, select the file, 
and click Open. The imported Ab1 data file(s) will be displayed on the right side of the 
Analysis window. 

 

 

 

 

 

 

 

Note: You can select and import more than one file at a time by holding down the CTRL key. 

 

3. Click the Start Analysis button to analyze the Ab1 files. 

 

The ConsenSys Analysis window 

The main ConsenSys screen is divided into four general areas: 

1. The EPG Navigator, (moveable) 

2. An exon-specific summary 

3. The EPG panel 

4. Allele Typing Result Pane 
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The EPG Navigator 

 

 

 

 

 

 

 

 

 

Sample Navigator 

 

 

 

If several samples have been imported, click the drop-down arrow to select a specific sample for 
analysis. 

Allele Filter 

For combined analysis: if checked it will filter alleles based on SSO typing.  Unchecked, it will give only 
SBT results. 

 

 

 

 

 

 

When the check mark is in place, the Allele Filter will retest the sample against the filtered allele list. 
Remember that inserting a check mark will re-analyze the sample and all the edits that you’ve made 
will be deleted. 

 

For your protection, Fusion Research will display a message asking you to 
reconfirm your decision to use the Allele Filter with the sample. 
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Confirm Filter 
 

 
 

The Confirm Filter will either display or hide the confirmed allele pairs in the result pane. 
 

Nucleotide Caller 

 

 
Use the Nucleotide Caller to audit sequences that need modification by selecting the appropriate 
nucleotide.  

 Click the Plus  button to place an insertion marker 

 Click the Minus  button to insert a deletion marker 

Electropherogram Navigator 

 

 

 

 

 

 

 
 

LABType/ConsenSys Selection 

 

Use this drop-down control to switch between LABType and ConsenSys 
analysis. 

 

 



One Lambda | User Manual: HLA Fusion™ Research Software 3.0 (FUSREPGRX) 

 
HFR-MAN-v3.x.x-EN-00, Rev 0 43 

Loci Navigation 

 

Click the drop-down arrow to navigate between different loci including, IMGT/A, IMGT/B, IMGT/C 
and IMGT/Cw. 

Nucleotide position/Mismatch Navigator 

 

 

 

 

 

The number displayed indicates the currently-selected nucleotide as displayed on the 
electropherogram, (EPG) pane.  Use the drop-down to navigate to a critical mismatch with a 
highlighted allele pair. 

Reanalyze 

 

 

 

Clicking the Reanalyze button will perform a new analysis on the sample, but it will deactivate and 
undo any edits you’ve made to the EPG for this sample. 

Fusion Research will ask you to reconfirm the new analysis before proceeding. 

Comments 

 

 

 

Clicking the Comments button will open the “Comments and Warnings” window.  Any comments you 
add here will be saved with the sample. 
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Note that the Comments and Warnings window becomes read only after the session is saved and the 
Confirmed  button is pressed. 

More Tests 

 

A check mark placed here indicates that you recommend that additional tests be performed on the 
sample.  The More Tests column for a sample on the Session Summary Screen will indicate True if a 
check mark is placed here. 

 

Key List 

 

 

 

After you click the Key List button, a pop-up window appears which displays a list of shortcut keys 
and key combinations which can speed up and simplify editing, analysis and display navigation.  The 
following chart lists some of these keys. 

 

Shortcut  Description Shortcut  Description 

TAB 
Confirm the current IUB code call and 
move to the next unconfirmed position 

K Set the current IUB code to K 

A Set the current IUB code to A M Set the current IUB code to M 
A+Shift key Show/hide the A trace R Set the current IUB code to R 
A+Ctrl key Toggle the amino acid translation view S Set the current IUB code to S 

C Set the current IUB code to C V Set the current IUB code to V 
C+Shift key Show/hide the C trace  W Set the current IUB code to W 

G Set the current IUB code to G X Set the current IUB code to X 
G+Shift key Show/hide the G trace Y Set the current IUB code to Y 

T Set the current IUB code to G + Add an insertion marker at the current position 
T+Shift key Show/hide the T trace  - Insert deletion marker at current position 

B Set the current IUB code to B F Open the sequence find dialog 
D Set the current IUB code to D I Show/hide trace information 
H Set the current IUB code to H [ Step back through the sequence primer layers 
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Accept Base Call 

 

You can individually accept the close base calls determined by HLA Fusion™ 
Research. After you accept a base call, you are moved to the next marked base 
position. 

 

 

From the Analysis window: 
 

 Click Accept Base button to accept the computer-suggested base call and move to the next base. 

When you click the Accept Base button, Fusion Research highlights the mismatch in green on the 
EPG. 

 

Quick Reports 

 

 

 

 

 

Unlike a Full Report which opens a secondary Reports Menu, a Quick Report, (see sample) generates 
a more minimal report with sample name, date, EPG peaks and basic allele typing results. 

Click the down arrows to select the Locus and Exon region(s) to be covered by the quick report and 
click the OK button.  Place a check mark in the EPG check box if you want the EPG peaks included. 

 

Full Reports 

 

Clicking the Full Report button 
opens the Reports Menu. 

 

 

The Reports Menu allows you considerable flexibility in 
sorting, summarizing and filtering the presentation of 
report data. 
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SSaammppllee::  FFuullll  RReeppoorrtt  aass  aa  tteexxtt  ffiillee  

Filters 

Sample - Filter genotyping for all samples or for a specific sample. 

Locus – Display genotyping for all samples, or for specific loci, (i.e.; IMGT/A, IMGT/B, 
IMGT/C or IMGT/Cw. 

 

 Sort by 

Sample Name – Present genotyping results in alphabetical order by Sample Name. 

 OR 

Locus - Genotyping results will be ordered by locus. 

 

 Summary Options 

NMDP – The Default Setting 

Brief – Does not include the Summary or exons 

Differences – Includes exon information 

 

 Audit Options 

Save – Was the analysis saved? 

Confirm – Need info here 

 

 Mismatch Limits 

Here, you can set the allowable mismatch limits from zero to “Best Only,” “Best +1,” or “Best 
+2,” etc. 

 

 Sample List or Table format 

Here, you can specify if you want the report formatted as a sample list, or as a table – with or 
without alleles listed. 

 

Output Format 

Text – Creates a file saved in a text, 
“(.txt”) format. 

Excel – Outputs the full report as a 
spreadsheet in the “.xls” format. 

XML – Formats the report in the 
Extensible Markup Language, known 
more simply as XML. 
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Page Breaks – Inserts page breaks to separate report data over many pages. 

 

 Full Report Section 

Sample – For either of these two data options, your choices are to leave the sample section 
empty, match the sample to the Summary and auditing. 

Layers – This section allow you to select up to four fields with the following data: The 
electropherogram list, by sequences, Edit List and Mismatch List. 

 

 Additional Information 

These extra fields located at the bottom, left of the Report Menu allow you to insert 
supplementary information about the analysis. 

 

After making your selections: 

1. Click the Report  button. 

The Select File window opens. 

2. Select a directory or folder location to save the report file. 

3. In the File Name field at the bottom, left of the screen, give the report a unique file name. 

4. Click the Save  button. 

The previous Reports Menu screen opens. 

5. Click the Done  button to close. 

 

Click the Update  button at the bottom of the Reports Menu and Fusion Research will 
remember the format and criteria selections you’ve made for use in future reports. 

Save > > 

 

Clicking the Save >> button stores the results of your analysis to the database. 

Confirm >> 

 

The Confirm >> button becomes visible only after you’ve clicked the Save>> button. 
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EEPPGG  
ppoossiittiioonn  

iinnddiiccaattoorr  

MMaaggeennttaa  ccoolloorr  
iinnddiiccaatteess  aa  mmiissmmaattcchh  EExxoonn  ssiitteess  

EEPPGG  
ppoossiittiioonn  
IInnddiiccaattoorr  

RRiigghhtt  aarrrrooww  ddiirreeccttiioonn  
iinnddiiccaatteess  aa  ffoorrwwaarrdd  sseeqquueennccee  

Close 

 
Clicking the Close button exits you from ConsenSys application, but not from Fusion Research. 

Exon-Specific Summary Pane 

 

 

 

 

 

 Numbers located at the top left corner indicate each exon site. 

 A right pointing arrow indicates a forward sequence. 

 The length of the line indicates the coverage of the sequence. 

 
 
 
 
 
 
 
 
 
 

 A left-pointing arrow indicates a reverse sequence and its length indicates the coverage of that 
sequence. 

 The short, magenta-colored vertical bars indicate positions that require auditing.  These are 
polymorphic nucleotides sites that could change the final allele pair assignment. 

 The long vertical bar indicates your current position within the EPG pane. 

 

LLeefftt  aarrrrooww  
ddiirreeccttiioonn  

iinnddiiccaatteess  aa  
rreevveerrssee  

sseeqquueennccee  
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Exon Summary Pane Right-click Options 

 

Set Start Base: Ignore all bases left (in the 5’ direction) from the current 
cursor position, (this is effective only for the exon where the cursor is 
placed).  This function is used to trim bases that are not interpretable.  All 
unique sequence polymorphism that exists will also be ignored and 
possibly result in more alleles assigned. 
 

Set End Base: Ignore all bases right (in the 3’ direction) from the current 
cursor position, (this is effective only for the exon where the cursor is 
placed).  This function is used to trim bases that are not interpretable.  All 
unique sequence polymorphism that exists will also be ignored and 
possibly results in more alleles assigned. 
 

Less Sensitivity: Forces a reanalysis of an EPG after reducing the detection limit. 
This function is very effective for improving the base call accuracy of data with 
high background. 
 

More Sensitivity: Forces a reanalysis of an EPG after increasing the detection limit. 
This function is very effective for improving base call accuracy of data with low 
signal. 
 

Reanalyze EPG: Re-analze EPG and discard all edits made.  
 

Deactivate EPG: Remove the EPG from the analysis completely.  Useful to ignore poor 
quality extension data. 
 

The Reference Sequence displays a magenta highlight around bases that differ between the 
reference and consensus sequences. 

 

These bases need to be individually viewed and accepted or edited. 

 Blue highlights between the reference and consensus sequences indicate the location of 
manually-edited bases. 

The ConsenSys Sequence is the combined consensus between both the forward and reverse primers. It 
displays any manually edited bases. 

 A Green highlight on a base in the Consensus Sequence indicates an accepted base. 

 Hold down the Shift  Key and use the Up  and down arrow keys on your keyboard to 
change the size of the electropherogram. 

 Right-click an electropherogram to display a pop-out menu with more options. 
 

Note: Press the letter “Z” while viewing the EPG to magnify the area where the position indicator is 
located. 



One Lambda | User Manual: HLA Fusion™ Research Software 3.0 (FUSREPGRX) 

 
HFR-MAN-v3.x.x-EN-00, Rev 0 50 

NNuucclleeoottiiddee  
ppoossiittiioonn  

RReeffeerreennccee  
sseeqquueennccee  
ffoorr    llooccii  

CCoommbbiinneedd  ffoorrwwaarrdd  
&&  rreevveerrssee  sseeqquueennccee    

SSaammppllee  nnaammee  
((>>>>  iinnddiiccaatteess  ffoorrwwaarrdd))  

NNuucclleeoottiiddee  ssiiggnnaall  
iinntteennssiittyy  

EEPPGG  

CClliicckk  aanndd  ddrraagg  
ttoo  ssccrroollll  qquuiicckkllyy  

FFoorrwwaarrdd  
sseeqquueennccee  
rreeaadd  

SSaammppllee  nnaammee  
((<<<<  iinnddiiccaatteess  rreevveerrssee))  

RReevveerrssee  
sseeqquueennccee  
rreeaadd  NNuucclleeoottiiddee  

aavveerraaggee  ssiiggnnaall  
iinntteennssiittyy  

EEPPGG  

 
EPG Panel 

 

 

 

 

 

Allele Typing Result Pane 
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AAssssiiggnnmmeenntt  BBuuttttoonnss  

CClliicckk  aanndd  
ddrraagg  ttoo  ssccrroollll  
uupp  aanndd  
ddoowwnn  tthhee  
AAlllleellee  PPaaiirrss  
LLiisstt..  

EPG Pane 

 

The EPG pane is the visual representation of the sequencing reaction. Here you can view the base call 
and edit any mismatched base calls in the EPG navigator. 

 

 

 

 

 

 

 

 

 

 

Edit Base Calls 

Any base call can be edited. The base assignment button is 
highlighted for the currently selected base. More than one base 
can be selected at a time and the corresponding base code is 
displayed. If no bases are highlighted, an asterisk (*) is 
displayed in the consensus sequence. 

 Select a base and click one or more of the assignment buttons to change the base assignment. 

 

Navigating the Alignment Screens 

The alignment screens were designed to give the end user all the tools necessary to: 

 Analyze sequence data between samples 

 Ascertain quality 

 Check against IMGT/HLA reference sequences for allele pairs 

 Check against all IMGT/HLA alleles for the loci of interest. 

 
Use the Ctrl key plus a Bracket key, (  + [ or  + ]) to navigate between the various alignments: 
 

1. Sample alignment 
2. Sample Base Call Score alignment 
3. Allele pair alignment 
4. Reference allele alignment 
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Sample Alignment 

 

 

Four samples were imported into this 
session. 

This sample alignment displays four 
sequences which correspond to the four 
different samples. 

On this screen, use  + [ or  + ] to 
display nucleotide vs. dots. 

Sample Base Call Score Alignment 

Generally the first 20-50 bp of a sequence read will be poor, the next 200-400 bases will have an 
improved quality sequence before gradually deteriorating again at the opposite end. 

 

 
 
 
This figure shows an example of poor quality data at 5’ and 3’ end with improved quality data in the 
center. 
 
 

 

Four samples were imported into this 
session. This alignment reflects the integrity 
of the peak shape, the background and the 
separation from neighboring peaks. 

White = High BCS value/good quality 

Red = Low BCS value/poor quality 

Use  + [ or  + ] to switch between 
nucleotide and dots. 
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Allele Pair Alignment 
 

The Allele Pair Alignment Window displays the alignment for the allele pairs that correspond to 
the sample being analyzed. This window will aid the end user when auditing sequence data. In this 
window the end user can narrow down which allele of the allele pairs is positive for the nucleotide that 
was sequenced. You can view the sequence of both allele pairs together or individually by turning Allele 
1 or Allele 2 on and off. 

 
 
 
 
 
 
 
 
 

 

If an allele header is highlighted green then the allele is being aligned in the EPG window. If you click 
on Allele1 or Allele2 you will be turning off the sequence and the header will change color from green 
to red. Use  + [ or  + ] to switch between nucleotide and dots. 

 
1. Reference Allele Alignment 

 
The sequence of each allele is aligned in the Allele Alignment Window. This window is useful when 
you’re specifically looking to cross reference sequence data with an individual allele. Use  + [ or  
+ ] to switch between nucleotide and dots. 

 

 
 
 
 
 
 
 
 
 

 
Analysis Workflow 
 
After you successfully imported your data: 

1. Audit the assigned nucleotides at every position making sure to audit the mismatched sites for 
the quality of sequence data, ambiguity and polymorphism. 

If changes are required, use the nucleotide auditor to edit and accept audits. (Clicking the 
Tab button on the keyboard automatically accepts the base call.) 

2. After all base calls are audited click the Save>>  button.  Click the Confirm  
button to save your sequence typing. 

 
This will change the red box next to the sample name from red to green to indicate that the 
sample has been typed. 
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TThhee  SSSSOO  HHoommee  PPaaggee  

CClliicckk  hheerree  ttoo  
ooppeenn  tthhee  
NNaavviiggaattoorr  

CClliicckk  ttoo  ooppeenn  
tthhee  KKIIRR  AAnnaallyyssiiss  
CCoonnffiigguurraattiioonn  
SSccrreeeenn..    

CClliicckk  tthhee  bblluuee  
lliinnkkss  ttoo  ddiissppllaayy  
tthhee  sseelleecctteedd  
ccaattaalloogg,,  wwoorrkksshheeeett  
oorr  pprroobbee//pprriimmeerr  
ddooccuummeennttss..  

FFuussiioonn  
EExxpplloorreerr  

NNoottiiffiiccaattiioonn  tthhaatt  nneeww  oorr  uuppddaatteedd  
ccaattaallooggss,,  NNMMDDPP  aanndd  SSeerroollooggyy  

eeqquuiivvaalleenntt  ffiilleess  mmaayy  bbee  aavvaaiillaabbllee..  
OOppeennss  tthhee  UUppddaattee  

RReeffeerreennccee  FFiillee  wwiinnddooww  
OOppeennss    tthhee  CCaattaalloogg  

MMaannaaggeemmeenntt  wwiinnddooww  

 

SSO Analysis 
The SSO Genotyping analysis feature of HLA Fusion Research analyzes three Luminex .CSV output 
files as a new session and can continue the analysis of a previously unfinished session. 

Starting SSO Analysis 

SSO analysis results are based on catalog specifications that are provided with the software. You can 
analyze samples one at a time in order to view, adjust and assign results for each one. 

Opening a SSO Analysis Session 

 Select the SSO Home page  button or the SSO  toolbar button.  

 

The SSO Home page is displayed. 
        

Note: Open worksheets and probe/primer sheets to verify the accuracy of revision numbers, (these 
documents do not contain a revision number in their filename). 
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SSeessssiioonn  IIDD  CCaattaalloogg  IIDD  

DDaattee  mmaayy  bbee  hhiigghhlliigghhtteedd  
iinn  yyeellllooww  iiff  rreeggiioonnaall  sseettttiinnggss  

ddoo  nnoott  mmaattcchh  bbeettwweeeenn  
tthhee  ccuurrrreenntt  CCSSVV  ffiillee  aanndd  

FFuussiioonn  RReesseeaarrcchh..  
CClliicckk  ttoo  ooppeenn  tthhee  

IImmppoorrtt  PPaattiieenntt  SSccrreeeenn  

CClliicckk  ttoo  aassssiiggnn  ppaattiieenntt  ttyyppee  
ttoo  ccoorrrreessppoonnddiinngg  PPaattiieenntt  IIDD  

DDoouubbllee--cclliicckk  
hheerree  ttoo  sseeee  
tthhee  ccuurrrreenntt  
ppaattiieenntt  lliisstt..  

LLiissttss  tthhee  
PPoossiittiivvee  

CCoonnttrrooll  ((PPCC))  
vvaalluueess  ffoorr  

eeaacchh  
ssaammppllee..  

PPllaaccee  aa  cchheecckk  
mmaarrkk  hheerree  

ttoo  aallllooww  aauuttoo  
aannaallyyssiiss  ooff  aallll  

sseessssiioonn  
ssaammpplleess  

uuppoonn  iimmppoorrtt..  

DDoouubbllee--cclliicckk  
hheerree  ttoo  ooppeenn  

tthhee  SSeelleecctt  
SSaammppllee  ssccrreeeenn..  

SSaammppllee  IIDD’’ss  
ccaann  bbee  eeddiitteedd..  

SSeettss  tthhee  
PPaattiieenntt  IIDD  
ttoo  bbee  tthhee  

ssaammee  aass  tthhee  
SSaammppllee  IIDD..  

LLuummiinneexx  
CCSSVV  

  SSeessssiioonn  
ffiilleess  

LLiissttss  
pprreevviioouussllyy  
IImmppoorrtteedd  
CCSSVV  ffiilleess  

 

Note: HLA Fusion Research converts Luminex-generated CSV file data, such as date and time, to the 
local regional code if a regional code is specified in the CSV file. (A regional code cannot be 
specified for CSV files created with Luminex software version 2.2 or earlier.) If the first date field 
is highlighted yellow, it indicates a regional code mismatch. In this case, it is recommended that 
you use the drop-down selector in the second date field to choose the appropriate date, taking into 
consideration regional date format differences. 
 

To begin an SSO session, do the following: 

1. Select a file from the list of CSV files to import, or click the folder icon above the list to browse 
to SSO session files(s) on your system/network. 

 

If samples in a session have a positive control value below the minimum 
setting, they are flagged so you can easily select and delete them from 
the session.   

Previously imported CSV session files have a tan or light brown 
background. 

 

 

2. Place a check mark next to the CSV session file you want to open. 

 

The SSO Session Import Screen opens. 
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The system assigns a Session ID, (the CSV filename) automatically. Optionally, you can change the 
ID. The ID can be alphanumeric, (containing letters and numbers) and will be listed alphabetically 
with any other SSO session files in your database. 

If a sample is already associated with a patient, the Patient ID and any existing, related patient 
information is displayed. 

To add patient information, do one of the following: 

 To add data from the system, double-click in the Patient ID column of the Sample/Patient 
Details table or click the Patient  button on the toolbar. 

The Import Patient window is displayed, allowing you to import the patient information file. 

 To manually add patient data, type data directly into the patient-related fields of the table. 

 You can assign the Sample ID to empty Patient ID fields by selecting the check box for Set 
empty patient ID to Sample. 

3. Select a catalog file. Your catalog file selection method varies, depending on the CSV file and 
the catalog files you have previously imported for LABType. 

If you need to import more catalogs, click the [Download] link on the LABtype home page to 
add new catalog files to the database. 

Note: The catalog drop-down list may not be immediately updated if you downloaded the catalogs 
during the current import session. You may need to click the Home  button and then click the 
LABType  button again to return to the import process. 

If the CSV file specifies a template name, (only applies to CSV files from Luminex 2.2 and later) and 
one of the available catalog files is associated with that template, then that catalog file is automatically 
selected. 

Note: You can also select a different catalog file from the one the system has selected by using the 
drop-down list in the Catalog ID field and selecting any catalog file listed. 

If there is no template match, the system then considers the closest bead match between the session 
and all available catalog files. If only one catalog file is a close match, it is automatically selected.  

If there is more

 

 than one match, a Catalog Validation screen is displayed with the best bead 
matches.  

4. Clicking the 
Close  
button also 
means that you 
confirm the 
selection of this 
catalog. 

 

 

Or, you can double-click a catalog file name on the list of other Suggested Catalogs, listed below. 
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Click the Detail  button and Fusion Research will display information about bead mismatches 
between the selected catalog and the CSV file. 

Following catalog file validation, the system may ask you if you would like to associate that template 
name with the specified catalog file. If you click Yes to associate the two, the system automatically 
selects this catalog file for all future imports of any CSV files that reference this template. 

 

 

Select the check box if you don’t want 
Fusion to continue asking if you want 
to associate templates and catalogs. 

 

If you change your mind, go to 
Utilities > Catalog Template 
Association and place a check mark 
in the bottom, left corner next to 
Enable During CSV Import. 

 

 

5. On the Sample/Patient Details Table, check to see if there are any samples that have been 
flagged as having a low positive control (PC); the rows of low PC samples are highlighted gray. 

Take the following steps if you want to delete any of these samples: 

Click in the border to the left of the Well position column to highlight the entire row for the sample. 

 

 

 

 

 

 

 

 

 

 

 

Press the Delete  key on your computer keyboard to delete the sample and prevent it from being 
imported as part of the session. 

 

6. When session and sample information has been verified, click the Import  button. 
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SSSSOO  AAnnaallyyssiiss  SSccrreeeenn  

 

The newly imported session is displayed in the Navigator tree, at the 
top of the list. 

If you had selected the Auto Analysis check box, the session is 
imported as well as analyzed when you clicked the Import  
button; it is now displayed on the Navigator as an analyzed session. 

 

 

You can continue importing Luminex session files, or you can click a session on the Navigator to start a 
batch analysis. 

 

Note: Once a CSV file has been imported, it no longer displays on the Luminex session import list 
unless you select the Include Imported CSV check box at the top, left of the screen. 
 

Displaying an SSO Analysis Window 

 

1. Open a SSO session. 

2. Click on a sample to display its analysis in the Analysis Window. 

The SSO Analysis window is divided into four quadrants: 
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SSSSOO  CCoonnffiigguurraattiioonn  MMeennuu  

SSaammppllee  NNaavviiggaattiioonn  bbuuttttoonnss  

Select a sample from this list to make the sample active in the Analysis window. Alternatively, you 
can use the arrow buttons to navigate between the samples. 

 
 
 
 
 

 

 Click any column header among the sample list to sort the table by that column. 

 Click the arrow buttons to display the samples according to the sorting criteria. 

 

Histograms 

Double click on a sample histogram in quadrant 2 to make that sample active. The color of the selected 
sample histogram in quadrant 2 will change to red and the selected sample profile will be displayed in 
quadrant 3. 

Configuring SSO Data Analysis 

The Configuration Menu allows you to define certain parameters for the analysis. Click on the Set 
Config  button, (or anywhere in the gray area to the left of the button) to display the pop-out 
Configuration Menu. 

 

 

 

 

 

 

 

 

 

 

P Grouping 

Codes allele strings in P Grouping as published by IMGT. 

G Grouping 

Codes allele strings in G Grouping as published by IMGT. 
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Minimum Positive Control 

The default Minimum Positive Control value assigned by the system is 1000. If desired, you can enter a 
new value into the Minimum Positive Control Value field. 

If the positive control bead count for a sample is lower

In sample analysis, each sample is processed individually. Results can be viewed, adjusted and final 
typing assignments made. 

 than the entered value, a warning is displayed. 

Using batch analysis, all samples are processed at once and no assignments or changes can be made 
during analysis. You can continue the session to make adjustments and assignments. 

Minimum Bead Count 

The default Minimum Bead Count Value assigned by the system is 100. If desired, you can enter a 
new value in the Minimum Bead Count Value field. A warning is displayed if the count for any bead in 
a test falls below the Minimum Bead Count threshold. 

Set Sure Reaction Bead 

Selecting the Set Sure Reaction Bead option in the configuration menu displays a new window, as 
shown below. In this window, you can force positive or negative bead ID values by typing in the box. 
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SSO Analysis Window Overview 
From the SSO Analysis window you can: 

 View sample analysis results 

 Change histogram scaling 

 Add comments and mark samples for more testing 

 Print analysis information and reports 

 

For each sample in the current session, you can view the test data, adjust the cut-off and assign a 
typing. 

HLA Fusion™ Research analyzes a sample when you move to view that sample. Any unviewed samples 
do not have analysis results when the session is saved. To analyze an entire session, all samples in the 
session must be viewed and typings assigned by the user. 

 

Using the SSO Data Analysis window  

The Sample Analysis Screen provides detailed analysis information for each sample in the session. 
You can review the typing assignments suggested by the program and to modify and accept the 
assignments. HLA Fusion™ Research suggests possible typing results, but the final assignment is 
made by the user. Cut-off adjustments made in the Analysis window are sample-specific and affect 
only individual samples. 

SSO Analysis window - Quadrant 1 

QC Tab 

Quadrant 1 displays the QC data histogram for the currently selected bead in the QC tab. Each bar 
represents a QC sample and its height represents the normalized reaction value for the selected bead in 
that sample. 

 

 

 

Hover your cursor over any sample to display 
the sample details, as shown here. 
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RReeaaccttiioonn  
TTaabbllee  TTaabb  TThhee  FFiinndd  

AAlllleellee  bbuuttttoonn  
CClliicckk  ttoo  rreesseett  ttaabbllee  ttoo  iittss  
oorriiggiinnaall  ccoonnffiigguurraattiioonn  

TThhee  
mmaaxxiimmiizzee//  
mmiinniimmiizzee  
bbuuttttoonn  

TTyyppee  
AAlllleellee  

hheerree  

 

 

To change the histogram scale, click inside the Max Scale 
box, type in new limits, and press the Enter  key on 
your keyboard. 

This changes the maximum scale for the histograms in 
quadrants 1 and 2. You can change the scale back to a new 
value the same way. 

 
 

Reaction Patterns Tab 

In the Analysis window of Quadrant 1, click on the Rxn tab to display the Reaction Pattern Table. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Type all or part of an allele into the text box and click the Find Allele  button to display that 
reaction pattern, or patterns, beginning in the first row of the table. 

To Sort beads by reactivity for the allele, click on the gray area on the left of the allele name. The 
positive reactions will be moved to the left of the table. Click on the Rxn Reset  button to reset 
the table to the original configuration. 

Double-click either in the light blue area between the Find Allele and Maximize/Minimize button, 
or click the Max/Min  button and the reaction table will be expanded. 

To bring the table back to its original size, double-click either area or button again. 

Click on any column header to Sort the table by well position. Positive reactions are listed above 
the blue line, and negative reactions below. 
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LLooccaall  QQCC  TTaabb  

OOnnee  LLaammbbddaa  
ccuutt--ooffff  lliinnee  

Local QC Tab 

 

The Local QC

 

 tab displays a histogram of the reaction profile for the current bead against all samples 
this user has ever run for the same product, (same lot/revision) and over a specified date range. 

 

 

 

 

 

 

 

 

 

 
 
Each Green bar represents a QC sample and its height represents the normalized reaction value. This  
serves as a user-created QC graph. 
 

 Hover your cursor over any sample, and the sample details are displayed. 

 The graph is continually updated as you analyze the product over time. 

 The cut-off line represents the One Lambda default cut-off value. 

 

Patient/Sample Results Tab 

 

The Patient/Sample Results tab details all of the results for all 
the tests done on a Sample ID or Patient ID.  As results are saved for 
each locus, either the serology result or the allele code for each loci 
appears in this all-loci section. 

Click on any of the labeled Gray tabs along the top of the grid to sort 
the results in either ascending or descending order. The direction of 
the small triangles  indicate how the results have been sorted. 

Hover your mouse over any Possible Allele Code to see the entire 
allele code. 
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PPaattiieenntt//SSaammppllee  RReessuullttss  ttaabb  

BBeeaadd  PPrrooffiillee  

 

You can use your mouse to widen the grid, or double-click between 
the tabs to automatically increase the column width to 
accommodate all the data presented. 

 

 

 

 

 

 

 

 

 

 

SSO Analysis window - Quadrant 2 

Bead Profile 

The Bead profile tab displays the histogram for the currently selected bead. Each bar represents a 
sample and its height represents the normalized reaction value for the selected bead in that sample. 
The red bar represents the currently selected sample. 

Click the arrow buttons to navigate between beads and display the profile of the selected bead in 
Quadrant 2. 

 

 

 

 

 

 

 

 

 

 

 

 



One Lambda | User Manual: HLA Fusion™ Research Software 3.0 (FUSREPGRX) 

 
HFR-MAN-v3.x.x-EN-00, Rev 0 65 

Alternatively, you can select the bead from the Bead drop-down choices. 

 

Hover your cursor over any 
sample. 

 

 

 

 

 

The sample details are displayed, 
as shown here. 

 

 

 

 

If you wish to exclude a bead from analysis, you can select 
the check box for Exclude. 

 

 

Click on the Reset button to reset the changed values back to default. The following options are 
displayed to choose from. 

 

 

Raw Data Table 

Select the Raw Tab and the Raw Data Table displays all raw data and test details for the current 
sample. 

 

 



One Lambda | User Manual: HLA Fusion™ Research Software 3.0 (FUSREPGRX) 

 
HFR-MAN-v3.x.x-EN-00, Rev 0 66 

TThhee  RRAAWW  ttaabbllee  
aafftteerr  ddoouubbllee--cclliicckkiinngg  
oonn  tthhee  hheeaaddeerr  ffoorr  
tthhee  RRxxnn  ccoolluummnn..  

 

To change the threshold value, enter a new value in the Threshold field 
and press the Enter  key on your keyboard. 

 

 

Normalized bead values that fall within the specified threshold range of the cutoff for that bead are 
highlighted in yellow. 

Click the Maximize  button to expand the Raw Data Table. Click the button again to minimize it, 
(or double-click anywhere in the light blue area between the threshold box and the 
Maximize/Minimize button to expand the table). 

Clicking on any column header will sort the raw data table by that column. 

 

 

 

 

 

 

 

 

 
 
 
 

        

Bead Info Tab 

 

 

 

From the Analysis window in Quadrant 2, click the 
Bead Info tab to display the allele specificity of the 
selected bead. 
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QQuuaadd  33  ––  SSaammppllee  PPrrooffiillee  

SSO Analysis window - Quadrant 3 

Sample Profile 

The Sample Profile displays each bead in the currently selected sample. Each bar represents a bead in 
the sample sorted by bead number and its height represents the normalized reaction value for the 
selected bead in that sample. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Red = A positive reaction; Blue = A negative reaction; Green = The selected bead in quadrant 2. 

• The gray diamonds inside the histograms indicate the current cut-off position. Arrowheads 
identify the direction and position of cut off changes made to a bead. 

• Click arrow buttons on the toolbar to select a sample bar and display the selected sample in 
Quadrant 3. 

• Alternatively, you can also select a sample from under the Sample drop-down list in the 
toolbar. You can also select a sample by double-clicking on a sample bar in the Bead Profile 
histogram, (Quad 2). 

The Magenta and the wwhhiittee, (or non-colored bar on the right) represent the raw data values for the 
positive and negative control beads of a LABType assay: 

 

• X-axis:

• 
 Beads in numeric order. 

Y-axis:

• 
 Raw data value, (trimmed mean). 

Data points:

 

 Bars represent the raw data value of a bead vs. the sample reaction. 
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White 
NNeeggaattiivvee  
CCoonnttrrooll  

MMaaggeennttaa  
PPoossiittiivvee  
CCoonnttrrooll  

BBeeaaddss  

RRaaww  
DDaattaa  

VVaalluuee  

QQuuaaddrraanntt  33::  DDeellttaa  VViieeww  

 

 

 

 Positive control = 

Bar colors/display: 

 Negative control = 

Magenta 

 

White 

 

 

 

Hover your mouse pointer over any sample. 

 

 

The sample’s details are displayed, as shown 
here. 

 

 

 

You can expand the histogram by double-clicking anywhere in the light blue area between the View 
Delta  button and the Maximize  button. 

To resize the histogram to its original size, double-click on the light blue panel again, or click the 
Minimize  button. 

View Delta 

 

To view the Delta data, (the difference between the signal generated and the cutoff 
point for each bead) click the View Delta

 

 button. 
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DDoouubbllee--cclliicckk  
iinn  tthhee  UUsseerr  
CCoommmmeennttss  
ffiieelldd  hheerree……  

……ttoo  ooppeenn  
aa  llaarrggeerr  
CCoommmmeennttss  
ssccrreeeenn  hheerree..  

To go back to the normalized view, click the same button which now says View Normal . 

Would you prefer to make View Delta the default view

 

 so that it automatically displays each time you 
bring up a sample for analysis? 

 Save the layout while this quadrant is in the View Delta mode by clicking 
the Save Layout  button. 

 

After you exit Fusion and log in again, your SSO sessions will display in Quadrant 3 in View Delta 
mode. 

 

Comments 

You can add comments to the sample by typing in the Comment field at the bottom. Double-clicking 
in this text box invokes a new window to type comments in. 

 

 

 

 

 

 

 

 

 

 

SSO Analysis window - Quadrant 4 

SSO Results and Assignment panel 

 

Quadrant 4 displays the possible typing assignments for the current sample. 

 

The left side, (the Summary) shows possible allele pair assignments suggested by the 
software. 

The alleles highlighted in yellow are a positive match. 

The red ones are mismatches. 

The un-highlighted ones are negative. 
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You must make assignments manually. 

 

The right side shows possible coded assignments. 
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Analyze SSO Data 
From the Analysis window you can: 

 View raw data 

 View reaction patterns 

 View bead and sample details  

 View results and make typing assignments 

The raw data table can be used to easily review raw data, normalized data and cut-off values. The 
reaction pattern table can be used to compare reaction patterns. 

Reaction-specific pop-ups display the probe details and reaction data for the selected sample and 
probe. 
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AAssssiiggnn  AAllll  

AAssssiiggnn  
SSeelleecctteedd  

RReemmoovvee  

Make Typing Assignments in SSO Analysis 

HLA Fusion™ Research provides computer suggested assignments. Final typing assignments can only 
be made by the user. You can save multiple SSO Typing assignments. From the Analysis window you 
can assign typings and make manual assignments. 

Typing Assignments 

The SSO results are displayed in Quadrant 4 of the Analysis window. This quadrant is divided into 
three sections. The Summary section displays the system suggested results for the SSO locus groups, 
where the alleles highlighted in yellow are positive match, red highlighted are a mismatch, and the 
remaining un-highlighted ones are negative. 

To make a manual assignment, please follow the steps below. The Allele Assignment panel lists the 
possible allele pair results for the selected SSO locus groups. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Select an allele, (or several alleles by holding down the Ctrl Key on your keyboard) from the 
Summary, and click the Assign button to assign the SSO locus group in the Final Assignment panel. 

To assign allele pairs, select one or more pair results from the allele assignment panel and click 
Assign. 

Click the Assign All button to assign all Positive SSO locus groups. The selected allele(s) are displayed 
under the Final Assignment. 

To remove any or all alleles from Final Assignment sections, select them and click the Remove (X) 
button. 
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CClliicckk  ttoo  mmoovvee  
aalllleellee  iinnttoo  tthhee  
ffiinnaall  aassssiiggnnmmeenntt  
bbooxx  aabboovvee..  

TTyyppee  aalllleellee  
nnaammee  hheerree  iinn  
tthhee  mmaannuuaall  
aassssiiggnnmmeenntt  ffiieelldd..  

Flagging a Sample for Further Testing 

This option flags a sample for further testing in the current analysis session and in reports created in 
HLA Fusion™ Research. The More testing required flag is saved with the analysis. 

 

In the Analysis window, select the More Test check box below the 
Assignments area. 

 

 

Manual Assignments 

Manual assignments must be entered in standard format with each allele separated by two spaces. 

 

 

 

 

 

 

 

 

 

Type the allele name in the text box below the Final Assignment section and click the Up Arrow   
button. 

The newly entered allele is moved into the Final Assignment field. 

 

SSO Batch Analysis 

 

Batch analysis is carried out from the Session Summary screen. 

When the session summary for a new session is activated, a batch analysis is automatically run. Batch 
analysis allows you to quickly analyze a session and save it for later review and final assignments. You 
can graphically view samples during batch analysis, but no final typing assignments are made. 

From the Session Summary you can: 

• Run a Batch analysis for a session 

• View the Batch Analysis Summary Chart 
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Save Assignments 

Lab Technicians and Supervisors can save analysis results for further review and approval. Until 
approved, samples are marked as Ready. 

In the Analysis window, click the Save>>  button to save analysis results and move to the next 
sample. Prior to confirming, a sample can be re-saved, if needed. 

        

Confirm Assignments 

When an analysis has been saved, Lab Supervisors can review and confirm the analysis results. 

Confirmed samples are marked as Approved. 

The Confirm button is grayed-out  when you view a saved but as yet un-confirmed sample. 

The Confirm button becomes purple  when you view a sample which has been confirmed by the 
Lab Supervisor. Samples may be reconfirmed. 

From the Analysis window, click Confirm>> to confirm analysis results and move to the next 
sample. 

Note: The application records two levels of analysis reviews - Save and Confirm. For re-saved and 
reconfirmed analysis, only the last user to save or confirm is recorded. 
 

Print Screen 

Print Screen prints the entire, currently displayed analysis screen. 

From the Analysis window Menu Bar, click the Print Screen  button. A print preview screen is 
displayed in a new window if you wish to examine the image before sending it to the printer. 
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Micro SSP Analysis 
The Micro SSP analysis feature of HLA Fusion™ Research analyzes manually input reaction patterns 
as a new analysis session and can also continue the analysis of a previously unfinished session. Each 
session consists of as many samples as you wish to analyze with the same catalog information. It can 
also accept data from eGene and new samples can be added to an existing session. 

 

Analysis results are based on catalog specifications, NMDP code, and serology code references that are 
provided with the software. Micro SSP analysis uses NMDP cross codes. Fusion Research suggests the 
allele pair assignments, but the final assignment has to be made by the user. The results can be saved 
in the database for further review by Lab Technicians and for final approval by the Lab Supervisor(s). 
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CClliicckk  ttoo  eeddiitt  
tthhee  MMiiccrrooSSSSPP  
gglloobbaall  sseettttiinnggss..  

CClliicckk  aannyy  lliinnkk  
ttoo  ddiissppllaayy  tthhee  
sseelleecctteedd  ccaattaalloogg,,  
wwoorrkksshheeeett  oorr  
pprroobbee//pprriimmeerr  
wwoorrkksshheeeettss..  

CClliicckk  ttoo  ooppeenn  
tthhee  AAvvaaiillaabbllee  
RReeffeerreennccee  
UUppddaatteess  ssccrreeeenn..  
(catalogs display 
nomenclature dates 
and revision notes) 

CClliicckk  ttoo  ooppeenn  tthhee  CCaattaalloogg  MMaannaaggeemmeenntt  ssccrreeeenn..  

CClliicckk  ttoo  ooppeenn  
tthhee  UUppddaattee  
RReeffeerreennccee  FFiilleess  
ssccrreeeenn..  

Start Micro SSP Analysis 

1.  Click the Micro SSP  button on the Fusion Explorer, the Micro SSP  icon 
on the Fusion Toolbar, or select Analyze Data > Micro SSP. 

The Micro SSP Home page is displayed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note:  Open worksheets and probe/primer sheets to verify the accuracy of revision numbers, 
(these documents do not contain a revision number in their filename). 

Click the Batch Entry

 

 button at the top, left side of the screen. 

Place a check mark next to Include Imported if you also want to bring in 
batches which have previously been imported. 
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SSeelleecctt  llooccuuss  ttoo  ffiilltteerr  ccaattaalloogg  lliisstt  PPaattiieenntt  IIDD  FFiieelldd  

BBrroowwssee  ffoorr  
MMiiccrrooSSSSPP  ffiilleess  

SSaavvee  tthhee  ccuurrrreenntt  
bbaattcchh  iinnffoorrmmaattiioonn  

GGoo  ttoo  tthhee  
aannaallyyssiiss  ssccrreeeenn  SSttaarrtt  aa  nneeww  bbaattcchh  

SSaammppllee  NNaammee  ffiieelldd  

 

The Micro SSP Batch Entry window is displayed. 

 

 

 

Fusion assigns a Batch Name automatically. But you can change it. 

 

Note:  A batch must be unique to the Fusion database for each product type. If it already 
exists, the software prompts you to rename the batch. It is highly recommended that 
you do not use any special characters in this field since they may serve a specific 
purpose as field separators. 

Use the Browse  button at the bottom of the window to search for and import one or more Micro 
SSP files (.csv), or follow the steps below.  

1. Use the drop-down menu in the Locus Filter field to select a locus by which to filter the 
catalog listing. This will limit the catalog list in the next field to only those catalogs that include 
the selected locus. 

2. Use the drop-down menu in the Catalog

Note:  If you need to import more catalogs, click the 

 field to select a catalog file. 

Download link on the Micro SSP Home 
Page for instructions on how to add new catalog files to the database. 
 
The catalog drop-down list may not be immediately updated if you downloaded the 
catalogs during the same import session. You may need to click the Home  button 
and then open Micro SSP

3. Accept the session name in the 

 again to return to the import process. 

Session

4. Enter a name in the 

 field, or modify it. 

Sample Name

 

 field. 
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SSeelleecctt  GGeell  IImmaaggee  BBrroowwsseerr  

 

If this is an existing sample name, other fields such as the Patient ID and Ethnicity, are populated 
with existing data. You can also double-click in the Sample Name field to display the Select 
Sample window from which you can select a sample. 

5. Click the drop-down arrow in the Sample Date

6. Enter an ID in the 

 field and select a date.  The analysis window 
for this session is displayed. 

Patient ID

 

 field. If this is an existing patient/donor ID, other fields such as 
the First Name, Last Name and Ethnicity are pre-populated with existing data. You can also 
double-click in the Patient ID field to display the Select Patient window from which you can 
search for and select a Patient ID. 

 

 

 

 

 

 

 

 

7. If they are not already filled-in, you can enter the First Name and Last Name for the patient 
or donor in the appropriate fields. 

8. Click the drop-down arrows in the Ethnicity and Patient/Donor fields to choose ethnicity 
for either Patient, Donor or Both. 

9. If you want to associate a gel image with the sample, double-click in the Gel Image

Note:  Fusion supports the BMP, JPG, BMP, GIF, PNG and TIF image formats. However, 
certain versions of the TIF format may not be supported by the Windows version used 
on your computer. 

 field and 
browse to the location of the image you want to attach to the sample. 
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Repeat the above steps until you complete the batch information, or until you want to save and 
complete the batch later. 

Each Micro SSP batch session can consist of as many samples as you wish to analyze with the same, or 
with different catalog information. 

Take one of the following actions once you are ready to stop creating the batch: 

 Click the Next>  button to open the Micro SSP analysis window. 

 Click the Save  button to save the current batch information and return to it later. 

 Click New Batch  to begin creation of an additional batch. 

 Click Close  to exit the Batch Entry

 

 window. 
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MMiiccrroo  SSSSPP  SSaammppllee--LLeevveell  CCoonnffiigguurraattiioonn  MMeennuu  

Configure Micro SSP Data Analysis 
 

The Global defaults for Micro SSP product configurations can be set at one of two places: 

 The Micro SSP Home Page 

 The Utilities menu on the main HLA Fusion home screen. 

In addition, configurations can also be set from within the analysis window for the current Micro 
SSP sample by right-clicking anywhere on the Micro SSP analysis window and a pop-up list of 
configuration options will appear at the upper, left corner of the analysis screen. 

After an analysis has begun, you’ll need to right-click in the light blue area just to the right of the 
Find Allele  button to open the Micro SSP Configuration Menu. 

 

 

Assign Code 

 

By default, the system assigns NMDP codes to the alleles. However, the user can optionally change 
these codes to one of the following options: 

 No Code

 

 - The results, allele pairs assembled into a string with no formatted code, are 
simply condensed without applying a coded format. 

P Grouping -  

 G Grouping - 

Codes allele strings in P Grouping as published by IMGT. 

 

Codes allele strings in G Grouping as published by IMGT. 

Local Code

 

 - assigns user-defined code definitions, (code used by your Lab) for 
suggested code results. 

Cross Code - allows allele combinations that cross serological groups (e.g., EAPW = 
DRB1*04:03:01 DRB1*04:03:03). By default, cross coding is turned off

 

 so that allele 
pairs are condensed only within the same allele groups. 

Bw4/Bw6 in Serology - Bw4/Bw6 is added to the serology results. 
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Bw4/Bw6 in Serology 

 

 

Serology has identified many pairs of HLA-B alleles which appear to 
differ only at the Bw4/Bw6 region - the two mutually exclusive 
serological epitopes. 

If you select this option, Bw4/Bw6 is added

 

 to the serology results. 

 

 

 

Demographic Information 

 

 

 

The Demographic Information option allows you to 
organize alleles based on their frequency. 

 

 

 

 

Based on the demographic selection you make, HLA Fusion displays as many as three allele groups 
in the allele pairs list: 

 

 Group 1:

 

 Frequent on both alleles 

Group 2:

 

 Frequent on one or the other of the alleles only 

Group 3:

 

 Frequent on neither allele 

Note:  If the Demographic Information option is not active, it means you need to import an 
allele frequency input file. See the topic: “Importing Allele Frequency Files,” which 
is located in the section, “Updating Allele Frequency files.” 
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Using the Micro SSP Analysis Window 
 

The analysis window displays detailed analysis information for each sample in the session. You can 
review the allele assignments suggested by the program, modify and accept the assignments. 

HLA Fusion suggests possible typing results, but you must make the final assignment. Any 
adjustments made in the analysis window are sample-specific and affect only the current sample. 

From the Analysis Window you can do the following: 

 Use the test gel pane to change reactions and sample row positions. 

 Change the allowable number of false reactions. 

 Force one false reaction. 

 View and print sample analysis results. 

 Add comments and mark for more testing. 

You can return to a session summary from the analysis window 
any time by clicking the <<Summary 

 

link from the HLA Fusion 
toolbar next to the Sample ID. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

DDiissppllaayyss  
aalllleellee  
ppaaiirrss  

MMiiccrroo  SSSSPP  AAnnaallyyssiiss  ssccrreeeenn  

TThhee  RReessuullttss  
aarreeaa  

GGrroouuppss  aanndd  
CCoonnddeennsseess  
ppaaiirrss  wwiitthh  
tthhee  ssaammee  
rreeaaccttiioonn  
ppaatttteerrnn..  

TThhee  
rreeaaccttiioonn  
ppaatttteerrnn  
ttaabbllee..  

CClliicckk  hheerree  
ttoo  vviieeww  

oorr  aadddd  aa  
ggeell  iimmaaggee..  

IInnppuutt  aanndd  
aannaallyyssiiss  

ttaabblleess  
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Test Gel Pane 

The pane on the left side of the window displays each well of the 
test in rows that are intended to duplicate the test gel.  Each 
well is shown with a reaction button. 

When clicked or entered from the keyboard, you can modify the 
reaction for the selected well between the following settings: 

 8 = positive reaction 

 1 = negative reaction 

 0 = no clear amplification, (wells with a “0” will be 
excluded from analysis) 

 

 

 

Note:  If you right-click in the black area of the test gel pane, you can select a different 
order for the reactions when you click on a well: 0->1->8, or 8->1->0, etc. 

 

 After you analyze a tray, you can no longer add any 
more sample information to that tray. 

 If the sample has not
button on the bottom of this pane is labeled 

 been analyzed, the right most 
Analyze

If an analysis already exists for the sample, then the 
. 

button is labeled Re-Analyze

 This button is only enabled when a Sample ID has 

. 

been entered. If a Sample ID has not been entered 
when this button is clicked, the Sample ID field is 
flagged with "!" as being empty and no analysis is performed. 

 If other than the first well reaction (1H) is set to zero (0), a message displays, allowing 
you to see system-suggested reaction information to help you decide if you want to 
analyze the non-amp well with a positive or a negative score. If more than one well is set 
to zero, the message does not display, but the suggested reaction information can still 
be viewed. 
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HHeeaaddiinnggss  ttoo  llooookk  
ffoorr  wwhheenn  vviieewwiinngg  
ppoossssiibbllee  nnoonn--aammpp  
wweellll  rreessuullttss..  

VViieeww  WWeellll  DDeettaaiillss  ((wwiitthh  yyoouurr  mmoouussee  oovveerr  aa  wweellll))  

 

 

To see the possible reactions if the well was positive or 
negative, click Yes and scroll down the Possible Allele 
Pairs list to the headings, Neg Reaction and Pos 
Reaction

If neither type of result can be suggested, the heading is 

. 

No 
Solution

 

 and it will not be followed by any results. 

 

 

 

 

 

 

View Well Details 

 

You can view comprehensive details about the current sample by hovering your cursor over a well 
in the test gel area of the analysis window. 

 

 

 

 

 

 

Working with Gel Images 

 If you have a gel image already linked

OR 

 to the current sample, you can view it, or unlink 
it. 

 You can search for and link another

 

 gel image to the current sample. 
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ZZoooomm  IInn  ZZoooomm  OOuutt  TToo  lliinnkk  tthhee  iimmaaggee  ttoo  
tthhee  ccuurrrreenntt  ssaammppllee..  

CClliicckk  ttoo  
cclloossee  tthhee  
GGeell  VViieewweerr  

GGeell  IImmaaggee  VViieewweerr  

CClliicckk  ttoo  rroottaattee  
tthhee  ggeell  iimmaaggee  

 

Here’s how you can link a gel image to the current sample: 

 

1. Click the View Gel 
left of the gel image screen

 button at the bottom, 

currently linked to this sample, you’ll see this 
. If no image is 

message: “Gel Image does not Exist. Click Yes to 
Browse for an Image.” 

2. Click the Yes button and Fusion opens the 
Select Gel Image screen. 

3. Browse and select a new gel image. Click the 
Open  button.  

4. Fusion opens the Gel Image window and 
displays the gel image you’ve selected. The 
window can be resized if needed. 

 

 

 

 

 

 

If you want to link this image to this sample, 
click the Link Image 

 To zoom in, click the  button. 

 button. 

 To zoom out, click the - button. 

 To turn the image, click the Rotate  
 button. 
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To Unlink an image already associated with the current sample: 

1. Click the View Gel  button. 

2. When the image is displayed in the Gel Image viewer, click the Unlink  button, 
(which now replaces the Link button)

Add Samples 

. 

 

There are two methods that samples can be added and analyzed in a session: 

1. Click the Add New Sample  button. 

2. Type a new Sample ID, or Sample Name, in the Sample ID field, (above the gel image). 

 

 

 

 

 

3. Select the Sample Date by clicking the Down 
Arrow  in the Date field to the right of the 
Sample ID field. 

4. And click the Analyze  button. 

OR 

Here’s an alternate method to add existing 
samples

 

 for analysis in Micro SSP: 

1. Click the Sample Selection button to the right of the 
Sample ID field. 

2. Select an existing 
sample from the list of 
Available Samples. 

 You can use the text box 
at the top as a search 
tool. 

3. Click the OK button at 
the bottom of this 
window to move the sample from the list of Available 
Samples to the Sample ID text box above the gel 
image viewer. You may use the existing Sample Name, 
or create a new one. 
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BBeeaadd  IIDD’’ss  ffoorr  LLaabbTTyyppee  tteessttss  uusseedd  iinn  ccoommbbiinneedd  
aannaallyyssiiss  wwiitthh  tthhee  ccuurrrreenntt  MMiiccrroo  SSSSPP  ssaammppllee..  

DDoouubbllee--cclliicckk  aannyywwhheerree  iinn  tthhiiss  
aarreeaa  ttoo  eexxppaanndd  tthhee  ttaabbllee  

ttoo  hhaallff  tthhee  aannaallyyssiiss  wwiinnddooww..  

CClliicckk  ttoo  ssoorrtt  
tthhee  ttaabbllee  
bbyy  tthhee  
sseelleecctteedd  
wweellll  
rreeaaccttiioonnss..  

TThhee  MMaaxx  
bbuuttttoonn  
eexxppaannddss  tthhee  
rreeaaccttiioonn  ttaabbllee..  

SSeeaarrcchh  bbyy  
rreeaaccttiioonn  
ppaatttteerrnn  

SSeeaarrcchh  bbyy  AAlllleellee  

 

4. Select/create a Sample Date. 

5. Click the Analyze  button. 

6. When finished, click the Close  button, or click the Exit  button to close the gel 
viewer. 

 

Modify the Session Start Position 

 

For multi-test trays, you can skip tray positions to match your gel photos by clicking the Add New 
Sample

Rxn (Reaction) Tab 

 button until the correct test start position is displayed. 

 

The reaction pattern table displays the positive reactions for each well, or bead, if combined with 
LABType, (x-axis) versus every allele (y-axis) defined in the current catalog.  

 The Reaction Pattern Table is displayed in the right pane of the Micro SSP analysis window. 

 

 

 

 

 

 

 

 

 

 

Default configuration:  

 Wells, (beads if it’s a combined analysis with LABType) are sorted by sample reaction. 

  The Well ID depends on the row and location of the sample in the test gel pane. 

 The current sample appears in a Blue font, just below the cross loci row. 

 Positive alleles are listed below the sample row and are highlighted . 

 Cross loci wells are identified with the pound sign (#). 

 Salmon background shading indicates a false positive. 

 Green background shading indicates a false negative. 
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RRxxnn  TTaabbllee  ccoolluummnn  hheeaaddeerrss  

CClliicckk  oonn  aa  ggrraayy  ttiillee  ttoo  tthhee  lleefftt  ooff  aann  
aalllleellee  nnaammee  ttoo  mmoovvee  aallll  tthhee  bbeeaaddss  
wwiitthh  tthhaatt  rreeaaccttiioonn  ttoo  tthhee  lleefftt..  

 

Working with the Reaction (Rxn) Tab 

Positive reactions are displayed as an “X” on the table, (blue for the current sample and 
black for the remainder). PC, NC and excluded beads are displayed as “0” on the table. 

If you want to expand the table to full window size, click the  button. To minimize it again, 
click the  button. 

Double-click in the gray and light blue area just above the table, (see graphic) between the 
Find Allele and Max buttons to expand the table to half the analysis window. To size the 
table back to its original size, double-click in the same area again. 

Type an allele into the Search by Allele field, (top left corner of the Rxn Table) and click the 
Find Allele  button to search and display the allele and its reaction pattern in the first 
row. 

Double click on an allele name to bring that allele to the top of the table. You can bring all of a 
certain allele group to the top by entering an allele group (i.e., DRB1*07). 

Click on a gray tile to the left of an allele name, to move all the beads with that reaction to the 
left.  Click the Rxn Reset  button, (just above the Max button) to reset the table to its 
original configuration. 

When a column header, (along the top of the table) is clicked, the table is sorted by reaction 
criteria for that well or bead, (if combined with LABType). The first click sorts in ascending 
order from top to bottom, the second click sorts in descending order. 

If you use the Analyze Combined  button from the analysis window to analyze 
a LABType test and a Micro SSP test, the Bead IDs from the LABType test are displayed in the 
Well ID row on the Rxn table. These are recognizable by the bead ID followed by an 
underscore and a 0. 
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Number of Allowable False Reactions 

 

If HLA Fusion cannot determine any results that exactly match the reaction pattern entered, it 
analyzes the reaction assuming that there is one false reaction in the sample. 

If a solution still cannot be found, the system continues to search through additional false reactions 
until the number of allowable false reactions has been reached, or a solution is found. 

The false reaction setting allows you to set the number of allowable false reactions: 

Minimum setting = 0 
Maximum setting = 4 

 In the # False Rxn
arrow to change the number of allowable false 

 field, click the up or down 

reactions. 

 

Note:  Regardless of the maximum false reactions set here, sample analysis stops at the first 

Force One False Reaction 

false reaction found. 

 

When a sample has a result with no false reactions, (exact match result) the Force 1 feature forces 
HLA Fusion to re-analyze the reaction to allow for one possible false reaction in any well. This 
feature is used to search for results for which one additional reaction can change the results. 

1.  From the analysis window, click the Force 1  button to force Fusion to analyze the 

sample with one false reaction. 

 

Click the Reanalyze  button to reset the analysis to the original results. 

 

Click the Rxn Reset  button to return the Rxn Pattern table to the default settings. 
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Micro SSP Combined Analysis 
The HLA Fusion software supports a combined analysis feature. In a combined analysis, the 
reactions from two tests of the same sample are combined together in a single analysis.  The 
previous test must either have the same Sample ID or be associated with the same Patient ID. 

To combine results for a sample, you need to start or continue a Micro SSP allele-specific test and 
have a previously saved Micro SSP or LABType session to combine with it. After combining 
sessions, the possible typing assignments are displayed, and the reaction pattern table changes to 
reflect the reaction pattern of both tests. 

1.  In the analysis window, click on the Analyze Combined

The Combined Analysis window displays a list of previous sessions that have used the 
current sample and share the same Sample ID. 

 button below the reaction 
pattern table. 

 

 

 

 

 

 

 

 

2.  Select the desired previous session(s) by selecting the associated Combine

3. Click the 

 check box on the 
far left. 

Analyze  button at the bottom of the pop-up window. 

Note:  If you combine one sample in the previous nomenclature format with a sample in the 
newer nomenclature format, the possible and assigned allele pairs and code will be 
displayed in the new format. If the sample with the previous nomenclature format 
contains an allele that is not included in the new nomenclature, that older allele is 
dropped. 

To rerun the combined analysis, click the Reanalyze Combined  button. 

 If the nomenclature dates between the current one and the one(s) being combined with it 
conflict, then the session(s) you selected is highlighted Red. 
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If you click the Analyze  button and there is a conflict on nomenclature dates, a warning 
message is displayed that gives you the option of continuing or canceling the combined analysis. 
The nomenclature of the sample test you selected to combine with the current one will be used if 
you continue. 

 

Note: Notice that the Analyze Combined button in the analysis window changes to Reanalyze 
Combined button. This is an indication that the selected sessions have been combined. 
If sessions are combined, a note is added to the system comments box. 

 



One Lambda | User Manual: HLA Fusion™ Research Software 3.0 (FUSREPGRX) 

 
HFR-MAN-v3.x.x-EN-00, Rev 0 92 

Make Typing Assignments in Micro SSP Analysis 
HLA Fusion provides computer-suggested allele pairs and coded assignments. Final typing 
assignments can only be made by you, or your supervisor. 

From the analysis window you can do the following: 

 Switch between code formats  

 Apply Bw4/Bw6 to serology results 

 Apply frequency filters 

 Assign non-coded allele pairs 

 Assign a coded allele pair 

 Assign serology equivalents 

 Make manual assignments 

 Remove assignments 

 Save and confirm assignments 
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SSeelleecctt  aann  aalllleellee  ppaaiirr,,  
((oorr  ppaaiirrss))  aanndd  cclliicckk  
tthhiiss  bbuuttttoonn  ttoo  sseenndd  
tthheemm  ttoo  tthhee  ffiinnaall  
aassssiiggnnmmeenntt  aarreeaa..  

CClliicckk  tthhee  ““XX””  
bbuuttttoonn  ttoo  
rreemmoovvee  aalllleellee  
ppaaiirrss..  

DDoouubbllee--cclliicckk  
aa  ppaaiirr  ttoo  

aassssiiggnn  tthheemm  

TThhee  FFiinnaall  
AAssssiiggnnmmeenntt  

aarreeaa  

TThhee  MMaannuuaall  
EEnnttrryy  BBooxx  

The Pairs Tab 

 

The Pairs

 The list identifies the pairs and groups them by either full-match pairs, (no false 
reactions) or the number of false reactions. Results with false reactions are listed with 
the false reacting bead/well identified. 

 Tab displays the possible allele pairs results that match the reaction pattern for the 
sample. The pairs are suggested by the software. 

 The results display one allele pair per row. 

 Possible homozygous pairs are flagged in the Comment

 

 field. 

 

 

 

Assign an Allele Pair from the Suggested List 

1.  Double-click on an allele pair under the Possible Allele Pairs

Alternatively, you can click to highlight an allele pair on the list under the 

 to assign it to the final pairs 
assignment area. 

Pairs tab, and 
click the V

To remove an assignment, select the assignment on the 

 (assign) button next to the Assigned Allele Pairs title to add it to the final 
assignment area. 

Assigned Allele Pairs list and click the X

 

 
(remove) button. 
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HHoovvee  yyoouurr  
mmoouussee  ppooiinntteerr  

oovveerr  aann  aalllleellee  
ttoo  sseeee  iittss  ccooddee  

ddeeffiinniittiioonn..  

AA  mmaannuuaallllyy  
eenntteerreedd  
aassssiiggnnmmeenntt..  

The Match Tab 

 

This data grid displays the coded format of the actual allele pairings for the sample. A Matched 
Reaction Pair

 

 is a pair of alleles, (or group of alleles) with a reaction pattern that completely 
matches the reaction pattern of the current sample. 

 

 

 

 

 

 

 

 

 This result differs from the Possible Allele Code results.  The Possible Allele Code 

 Hovering your cursor over a coded allele format displays its code definition. 

condenses the results into a single code, where possible. 

Manual Allele Pair Assignment 

1.  Make sure you type the assignment in the correct allele code format: 

 New nomenclature format: X*##:##(####)  X*##:##(####), where X = locus type and # 
= code number.  

 Previous nomenclature format: X*#### X*####, where X = locus type and # = code 
number. 

 

 

 

 

 

 

 

 

 

Type an assignment into the text box directly below the Assigned Allele Pairs list. 

Press the Enter  key on your keyboard to move the typed allele upwards and into the Assigned 
Allele Pairs text box. 
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PPoossssiibbllee  
  aalllleellee  ccooddee  AAlllleellee  ccooddee  

ddeeffiinniittiioonn  

AAssssiiggnneedd  
aalllleellee  ccooddee  

Possible Allele Codes 

 

The Possible Allele Code

 

 field displays the possible coded results for all results that fully match the 
sample. The type of code used is dependent on your configuration selection: NMDP code, (default) 
local code, (user-defined) or no code. 

 

 

 

 

 

 

 

 

 

 The possible coded result is listed at the top section of the field. The code definition is listed 
below it. 

 If there are no codes for a particular suggestion, then the suggestion is listed with XX, 
meaning the code is undefined. For multiple XX suggestions, each suggestion is numbered 
as XX1, XX2, etc., to distinguish one from the other. 

 The allele codes displayed in the Possible Allele Code field are condensed by Fusion 
based on suggestions from the list of possible allele pairs displayed under the Pairs 

 The allele code is based on the current NMDP code, or local code installed in the system. By 
default, the system assigns the NMDP codes to the alleles. You can optionally change these 
codes to either No Code, Local Code or Cross Code. 

tab.  

 No Solution

 

 is listed if there are no results that match the sample’s reactions within the 
allowable number of false reactions. 

Allele Code Assignment 

1.  Double-click the possible allele code, or select the suggested code and click the V

Select an allele code and click the 

 (assign) 
button. 

X
 

 (remove) button to remove an allele code assignment. 
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Manual Allele Code Assignment 

1.  Type an assignment into the text field just below Assigned Allele Code. Make sure you 
type the assignment in correct allele code format: 

 New nomenclature format: X*##:##(####)  X*##:##(####), where X = locus type and # = 
code number. 

 Previous nomenclature format: X*#### X*####, where X = locus type and # = code 
number. 

Otherwise, the system does not accept it, and prompts you to make corrections. 

Note:  If you click on the Translate

 

 button to display alleles in the new nomenclature 
format, you cannot enter a manual allele code unless you reanalyze the sample and 
alleles are again displaying in the previous nomenclature format. 

Press the Enter  key to move the allele code you typed in to the Assigned Allele Code field. 

 

 

 

 

Note:  If you have a homozygous result, the assigned code can be edited in the Manual Allele 
Code field to show the homozygous-coded results once. 

Unknown Allele Codes 

Unknown allele codes are marked with XX followed by a sequential number. The numbers are reset 
to 1 for each sample and locus. When you see unknown codes, you should first make certain you 
have imported the latest NMDP file. 

If you have the latest code file, and are still seeing XX codes, you can store these unknowns for later 
submission to the NMDP in a .txt file named nmdp_code_report.txt. By default the text file is 
stored in C:\OLI Fusion\data\NMDPExport, but the location can be changed by modifying the 
Interface path (see the section: Setting HLA Fusion Default URLs and Directory Paths

 

).  Code 
information is appended to the end of this text file as it is added; the newest additions are at the 
bottom. 

1. From the Possible Allele Code area, select the XX code to enable the NMDP Code 
Report  button at the bottom of the screen. 
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CClliicckk  tthhee  
““XX””  bbuuttttoonn  
ttoo  ccaanncceell..  

……ttoo  eennaabbllee  
tthhee  NNMMDDPP  

rreeppoorrtt  
bbuuttttoonn  hheerree..  

SSeelleecctt  XXXX  
ccooddee  hheerree……  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Right-click the Report  button and choose one of the following: 

 

To send the unknown code information to NMDP, select 
Direct Request NMDP. 

 To add the unknown code information to a text file, 
(default location is 
Fusion\data\NMDPExport

C:\OLI 

file. 
), select Save in text 

 To add the unknown code information to an Excel file, 
(default location is 
Fusion\data\export\NMDPExport

C:\OLI 

Excel File, or simply left-click the mouse button. 
), select Save in 

 

3. When you’re done, click the  button to remove the buttons from display. 

Note:  The Rpt+ button retains the last selection you made, (direct, text or Excel) so it can 
be used as a shortcut; unless you want to change your selection, the next time you 
report XX code simply click the Rpt+ button. 
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XXXX  ccooddee  ssaavveedd  
aass  aa  sspprreeaaddsshheeeett  
((..ccssvv))  ffiillee..  

DDiirreecctt  ttoo  NNMMDDPP  

XXXX  ccooddee  ssaavveedd  aass  
aa  tteexxtt,,  ((..ttxxtt))  ffiillee..  

 

The following shows examples of each result: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Other Assignment 

 

The Other Assignment field can be used to make a sample assignment that is not restricted to 
any format. In addition, you can highlight and add serology or allele pair or code assignments and 
add them to the field for modification. 

 

 

 

 

 

 

You can make other code assignments one of two ways: 

 Type an allele pair, or allele code into the Other Assignment

 Click the Assign 

 field. 

V

1. To assign just the possible allele code, select 

 button and select one of two options: 

Assign Possible Allele Code

2. Choose 

.  

Assign All to bring the Possible Allele Code, Serology or Assigned Allele Pairs 
assignment(s) into the Other Assignment field. 
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RReemmoovvee  
bbuuttttoonn  

AAssssiiggnn  
bbuuttttoonn  

SSeerroollooggiiccaall  
aassssiiggnnmmeennttss  

RReellaatteedd  
AAlllleellee  
ppaaiirrss  

SSeerroollooggyy  
EEqquuiivvaalleenntt  

You can then choose to modify any of the copied code if desired. 

 The entered allele is assigned and is included in reports that are run that include this sample.  

 It is not listed in any final assignment fields for this sample. 

 

Possible Serology Field 

 

The serology equivalent field displays all serology equivalent suggestions for the sample based on 
the possible allele pairs. When you select a displayed serology equivalent, the allele pairs associated 
with it are displayed in the field below. 

Note:  Make sure you have imported the current serology equivalent file through the Utilities 
menu. If a zero (0) appears in the serology assignments, this means you need to 
import the current serology equivalent file. 

 Only one serology equivalent assignment for the sample can be made at a time. Therefore, a 
current serology assignment is replaced if you select and assign a different one. 

Note:  If this is a multi-loci test, more than one locus can be assigned. However, for single 
locus tests, only one locus can be assigned. 

 

 

 

 

 

 

 

 

 

 

 

 

1. Double-click a serology suggestion, or highlight it and click the V (assign) button to copy it 

to the Assigned Serology

 Select the a serology equivalent and click the 

 field. 

X

 

 (remove) button to remove it. Or, select and 
assign a different one to replace it. 
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YYoouurr  oowwnn  
CCoommmmeennttss  

((225555  cchhaarraacctteerrss  
mmaaxxiimmuumm))  

CCoommmmeennttss  
eenntteerreedd  bbyy  
HHLLAA  FFuussiioonn  

Translate (non-current nomenclature format only) 

 

The Translate  button is displayed if your alleles format is displayed with older 
nomenclature. Clicking the button does the following: 

 Displays all assigned, (except from the Other Assignment field) and possible allele 
code/pairs in the latest nomenclature format. If a matching allele in the new format cannot 
be found, the allele remains displayed in the old format. 

 You can view and print this display, but results cannot be saved or reported in this new 
nomenclature format. 

 To go back to the older allele format, you can navigate to another sample, and then return 
to this sample. 

Adding Comments to Samples 

 

Comments you, or Fusion adds to the Comments fields are displayed with the sample results in 
the current analysis session, data look up and reporting functions in HLA Fusion. 

1. In the analysis window, type sample comments into the Sample Comments

Or, double-click in the User Comments field to open a larger writing space. 

 field, 
(located just below the Assignments area). 

 

 

 

 

 

 

 

 

 

 

 

Comments are only saved after you click the Save 

 

 button. 
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Flagging a Sample for Further Testing 

 

You can indicate the need for further testing of a sample by selecting the More Tests check box 
followed by clicking the Save >>  button.  The More Tests indication is displayed in results, 
data look up and reports for the sample. 

 

 In the analysis window, click the More Tests check box, located 
below the Assignments area. 

 

Printing the Current Analysis Window 

 

The Print Screen button prints the currently displayed analysis window. 

 From the analysis window, click the Print Screen  button  on the toolbar to print the 
current analysis screen. 

 

Preview or Print Reports 

 
You can view/preview a Micro SSP report for the current sample by using the Preview Report 
and/or Print Report buttons on the HLA Fusion toolbar. 

 

 

In the analysis window, click the Preview Report button  or 
the Print Report button  to display a list of reports you can 
preview or print for the current sample. 

The drop-down report menus are identical whether you are 
previewing or printing a report. 

 

 

Note:  You cannot create a new Molecular Custom report directly from the analysis screen. 
The only custom reports available from the analysis window are ones you previously 
created through the reports window. 
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Assign Coded Results 

 

Use the Assign  button to designate and save all unambiguous possible coded results, (those 
results for which there is only one coded result). 

 

Save Assignments 

 

Lab Technicians and Supervisors can save analysis results for further review and approval. Saved 
samples are available for confirmation by a lab supervisor only

 From the analysis window, click the 

. 

Save  button, located in the bottom right corner 
of the analysis window to save the analysis results. 

 Fusion will automatically move to the next sample. 

 Samples must be saved in order to associate any user-created comments in the database or 
reports. For confirmation, a supervisor needs to access the sample for which you saved the 
assignments. 

 

Confirm Assignments 

 

Lab Supervisors can confirm analysis results. Samples are marked as Confirmed

 From the analysis window, click the 

. 

Confirm  button, located in the bottom right 
corner of the analysis window, to confirm all analysis results. 

You automatically move to the next sample to continue confirming results. 

When you first return to a confirmed sample, you see that the Confirm  button is now 
shaded purple to let you know it has been previously confirmed. 
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TThhee  FFiieelldd  
CChhoooosseerr  

bbuuttttoonn  

Micro SSP Session Summary 
The summary table can be launched by clicking on a session in the Navigation Tree on the far 
right of the screen. It lists each sample in the session and any saved analysis results. 

After opening a session: 

 Double-click a sample in the Summary Table to go directly to the analysis screen for that 
sample. 

 Click on the Field Chooser  button to the left of the table headings to display the Field 
Chooser. 

 

 

 

 

 

 

 

 

 

 

 

 

 

In this window you can select or clear the check boxes next to column headings to include or 
exclude those columns from the Summary Table. 

Selecting or clearing check boxes in this window instantly updates the Summary Table. 

Note:  If you do not see a particular field available through the field chooser, and you are 
sure it should be there, go to: C:\HLA Fusion\temp  and delete the file named 
SSP_Layout.xml

 Click on any column header of the Summary Table to sort the 

. 

table by that column. The small Up  or Down arrow in the 
column header indicates the sorting order: up for Ascending and 
down for Descending. 

 You can also click on a header and drag and drop it to change the 
column order. 
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 You can save any modifications you’ve made to the layout by 
clicking the Yes

Your changes are saved for all future Micro SSP session summaries 
on this same computer until further modifications are made and 
saved. 

 button in the message box when it appears. 

 

 Click the Export

 

 button, (located at the bottom of the screen) to save the Summary Table 
on your computer or network, (default location is C:\OLI FUSION\data\report). The 
file will be saved in the Excel spreadsheet (.XLS) format. 

 

 

 Click the Print

 Click the 

 button to create a hard copy of the Summary Table. 

Preview

 

 button to view and/or resize the Summary Table before printing. 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the print preview window, the page view slider on the left displays icons for each page of the 
report. 

 Click on a page representation, (left side) to display that page in the preview window on the 
right. 
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Navigator Right-Click Menu Options for Micro SSP 
HLA Fusion provides special menu options which are available when you right click on either a 
session, or a sample, in the Fusion Research Navigator. 

Session-Level Options 

There is a special session-level menu that displays if you right-click on an active session in the 
Navigator, (select the session first with a left-click) which allows you to reanalyze with new 
nomenclature: 

 

 

 

 

 

 

 

 

 

Reanalyze with New Nomenclature 

 

This feature allows the session to be reanalyzed using a new or 
updated catalog. 

 

 

 

1. After right-clicking on a session, the Select New Product screen opens. 

2. Rename the session. 

3. Click the drop-down arrow  in the New Catalog ID

4. Click the Analysis 

 field and select a new catalog from 
the list of available catalogs. 

 button. 

The session on which you right-clicked is now re-analyzed with the catalog you’ve selected. 
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SSaammppllee  IIDD’’ss  NNaavviiggaattiioonn  bbuuttttoonnss  

Sample-Level Options 

 

Two menu options are displayed if you right-click on an active 
sample

 

 in the Navigator, (remember to select the sample first 
with a left-click). 

Related Records 

 

A Related Record is a record that is associated with the current sample by Patient ID or Sample ID. 

Note:  This option is also available when you use the Related Records toolbar button . 

 Right click a sample from the Navigator and select Related Records to load all records 
related to the current sample into the Sample

 

 drop-down list, (at the top, center of the 
screen). 

 

 

 

 Use the sample navigation buttons to display the analysis of each related record one-by-one.  

To go back to viewing the samples in the current sessions, click the <<Summary

 

 link at the top of 
the window. 

Side by Side Analysis  

 

Use this option to compare the current sample analysis with one previously conducted. 

Note:  This option is also available when you use the Side-By-Side Analysis toolbar button 
. 
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SSiiddee--bbyy--SSiiddee  aannaallyyssiiss  ddiissppllaayy  

CCuurrrreenntt  
AAnnaallyyssiiss  

PPrreevviioouuss  
AAnnaallyyssiiss  

 

1. Right-click the sample, and select Side-by-Side Analysis

2. Select a previous sample analysis from the displayed list to compare it to the current one.  

. 

The two analysis windows are then displayed in a comparison window. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Each window can be resized and moved by dragging and dropping. 

 Click the Side-By-Side Analysis toolbar button again to cancel the comparison display. 
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Quantiplex Beads 
Quantiplex Beads™ data can be imported and used during LABScreen Analysis. When imported with 
LABScreen sessions you can view SFI values in bead pop-ups and raw data tables in the LABScreen 
analysis window. 
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CClliicckk  lliinnkkss  ttoo  
ddiissppllaayy  sseelleecctteedd  

ccaattaalloogg,,  
wwoorrkksshheeeett,,  oorr  
pprroobbee//pprriimmeerr  

ddooccuummeennttss..  

CClliicckk  ttoo  ooppeenn  tthhee  
CCaattaalloogg  MMaannaaggeerr  

  

CClliicckk  ttoo  ooppeenn  tthhee  UUppddaattee  
RReeffeerreennccee  ffiillee  wwiinnddooww  

CClliicckk  ttoo  ooppeenn  tthhee  
AAvvaaiillaabbllee  UUppddaattee  
RReeffeerreennccee  wwiinnddooww  

Entering and Using Quantiplex Bead Information 
You can select different Quantiplex Beads Sessions for use in LABScreen analysis. Quantiplex Beads 
Sessions cannot be changed after they have been imported. 

From the Main Menu you can: 

 Enter Quantiplex Beads sessions 

 Select a Quantiplex Beads session for use in LABScreen Analysis 

 View Quantiplex Beads SFI values in LABScreen Analysis 

 

Acquiring Quantiplex Beads Data 

 

1.  Select the Quantiplex Beads  button from the home page panel, or the Quantiplex 
Beads  button on the Fusion toolbar. 

 

 The Quantiplex Beads Home page is displayed. 

 

 

 

 

 

 

 

 

Note:  If you are not using the default Fusion user interface, the data and links shown on the 
right side of the window are not displayed. 
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SSeessssiioonn  
  

CCaattaalloogg  
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QQuuaannttiipplleexx  BBeeaaddss  
HHoommee  PPaaggee  bbuuttttoonn  

CClliicckk  ttoo  
bbrroowwssee  

ffoorr  
CCSSVV  
ffiilleess  

LLuummiinneexx  
CCSSVV  

sseessssiioonn  
ffiilleess  

 

 

2. If Luminex CSV files have not already been loaded into Fusion, 
click the small folder  icon located at the at the top, left. 

 

Note:  Open worksheets and probe/primer sheets to verify the accuracy of revision numbers 
(these documents do not contain a revision number in their filename). 

 

 

Select Luminex session(s) from the Select CSV 
Files List.  

3. Click the Open  button. 

 

The Quantiplex Beads Session Import

 

 screen 
displays. 
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Note:  A Session ID must be unique to the Fusion database. If the Session ID already exists, the 
software prompts you to rename the session. It is also highly recommended that you do 
not use any special characters in this field since they may serve a specific purpose as 
field separators. 

4. On the Session Import Screen, select a catalog file from the drop-down list in the Catalog ID

Note:  If you need to import more catalogs, click the [Download] link on the 

 
field. 

Quantiplex Beads 
Home Page. The catalog drop-down list may not be immediately updated if you 
downloaded the catalogs during the current import session. In this case, you may need 
to click the Home  button and then click the Quantiplex Beads  button again to 
continue the import process. 

 

5. Place a check mark in the Select Quantiplex
for all samples you want to import. 

 check box 

 

6. Click the Import 

The sample(s) are imported for use in LABScreen analysis sessions. 

 button. 

Start LABScreen Analysis with Quantiplex Beads 

 

Quantiplex Beads values can be viewed only with LABScreen Sessions started after the Quantiplex 
Beads Session has been entered. 

Start the import process for a LABScreen session with which you want to use Quantiplex Beads. 

1. From the LABScreen import window, select a Quantiplex Beads sample from the Quantiplex 
Beads 

2. Once you click 

drop-down list. 

Import 

 

for the LABScreen session, the selected Quantiplex Beads sample is 
imported as well. 

View SFI Information in LABScreen Analysis 

 

You can view Quantiplex Beads SFI values for each bead in the bead information pop-up or the raw 
data table of a LABScreen session. 

1. Place your cursor over a bead reaction bar on the LABScreen Analysis Window to view the bead 
pop-up with SFI values. 
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Click the Raw  button on the LABScreen analysis window to display the Raw Data table with SFI 
values. 

 

 

 

 

 

 

 

 

 

View MFI Information with Quantiplex Beads 

 

The Trimmed Mean Fluorescent Intensities, (MFI) of test samples can be converted into Standard 
Fluorescent Intensity (SFI) units by using the linear standard curve obtained for the Quantiplex Beads 
read in parallel on the same machine. 

1. If Luminex CSV files have not already been loaded into Fusion, click the small folder  icon 
located at the at the top, left. 

2. Select Luminex session(s) from the Select CSV Files List. 

3. Click the Open  button. 

The Quantiplex Beads Session Import

1. Place a check mark in the Select Quantiplex check box. 

 window displays. 

2. Click the Quantiplex SFI  button. 

The Quantiplex MFI screen opens. 
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HLA Fusion plots the linear standard Curve of 
Quantiplex Beads using SFI (y axis) vs. Trimmed Mean 
(x axis), both plotted on a log scale. 

If you select more than one sample, Fusion plots the 
average values. 
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SSeessssiioonn  SSuummmmaarryy  SSccrreeeenn  ((CCoonnsseennSSyyss))  

SSeessssiioonn  IIDD  

Session Summary and Logs 

 

What is the Session Summary? 

The session summary table presents a pre-analysis of the results. It lists each sample in the session 
and their saved analysis results. This option allows you to quickly analyze a session in HLA Fusion™ 
Research, and save it for later review and final assignments. You can graphically view samples during 
batch analysis, but no final typing assignments are made. The summary table can simply be launched 
by clicking on a session in the Navigation tree. 

 

Note: You can return to a session summary from the Analysis Window any time by clicking the 
<<Summary link at the top of the HLA Fusion™ Research toolbar next to the Sample/Session ID. 

Example Session Summary 

The figure below displays the session summary displayed by clicking on a session. The summary table 
displays the analysis results for each sample in the selected session. 

 
 
 
 
 
 
 
 
 

Creating and Managing Session Logs 

With HLA Fusion™ Research, you can create log files of your analysis sessions which you can then 
print or archive. 

 

Creating a Session Log 

1. On the HLA Fusion™ Research Menu Bar, click Data. 

The Data Management Screen opens. 

2. Provide all necessary session input information by using the drop-down menus and search 
buttons on the left side of the Data window. 
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TThhee  DDaattaa  MMaannaaggeemmeenntt  SSccrreeeenn   

 

 

 

 

 

 

 

 

 

 

 

 

3. Once a session is selected, its information is displayed on the right side of the window where 
you can add information. 

4. Once you have all information you want to include in the log, click Save. 

 

Managing Session Logs 

 

1. On the HLA Fusion™ Research Menu Bar, click Data. 

The Data Management Screen opens. 

1. Provide all necessary session input information by using the drop-down menus and search 
buttons on the left side of the Data window in order to bring up the session you want. 

2. Once you’ve displayed the session log you want, use the Archive  Unarchive  
and Delete  buttons at the bottom of the window to manage the Session Log. 

 

Printing Session Logs 

1. On the HLA Fusion™ Research Menu Bar, click Data. 

The Data Management Screen opens. 

1. Provide all necessary session input information by using the drop-down menus and search 
buttons on the left side of the Data window in order to bring up the session you want. 

2. Once you have displayed the session log you want, use the Print Session Log  
button at the bottom of the window to print a copy of the Session Log. 
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Reports 

 HLA Fusion™ Research provides different report formats in which to output your analysis data 

and results. 

From the Reports menu you can do the following: 

 Create, print and export reports for analysis data for all supported products 

 Create custom reports for which you determine content type 

 Create reports for electronic submission, such as NMDP HML reports 

 Store as many as 18 reports in a “My Favorites” list for convenient access 

 Modify the appearance of any report, such as fonts, formatting, and background colors 
(supervisors only) 

 

Note: To view reports, your computer must have some form of printer driver installed. If you do not 
have a printer driver installed, you can download a free copy of PDF Distiller from Adobe.com, or 
the Microsoft Office Document Image Writer from Microsoft.com. 

 

In addition, you can print and export these reports directly from an analysis or batch summary screen. 

 

Using the Reports Window 

 

The following sections describe how to create, save and print a report containing your analysis data.  

Here are the main steps you should take to create a report from this window: 

1.  Select a report type. 

2. As needed, select criteria to refine the report data, such as the date range. 

3. Select the sessions or samples to include in the report. 

4. Select the View Report or the Export Report

 

 button. 

Accessing the Reports Window 

Access the Reports window in one of two ways: 

 On the home page, click the Reports  button in the Fusion Explorer. 

 Or click  on the Fusion menu bar. 
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RReeppoorrtt  TTyyppeess  

The Reports window is displayed, with a list of any sessions that fall within the date range, based on 
the session date range set in the Find  dialog box. If no session are displayed, try modifying the date 
range. 

 

 

 

 

 

 

 

 

 

Select Report Type 

 

 Select a report from the report type menu options displayed at the top of the Reports

 

 window. 
The list of sessions in the right pane of the Reports window is filtered to display only the ones 
related to the selected report type. 

 



One Lambda | User Manual: HLA Fusion™ Research Software 3.0 (FUSREPGRX) 

 
HFR-MAN-v3.x.x-EN-00, Rev 0 118 

  
  
  
  
  
  
  
  
  
  
  
  
  
CClliicckk  ttoo  ffiilltteerr  sseessssiioonnss  
bbyy  sseelleecctteedd  ccrriitteerriiaa..  

SSaammppllee,,  sseessssiioonn  
ssttaattuuss  oorr  ootthheerr  
cchhaarraacctteerriissttiiccss  
aass  sseeaarrcchh  ccrriitteerriiaa  

Refine Report Input 

If needed, use the left panel of the Reports

 

 window, to further filter the sessions you want to include 
in your report. There are a number of criteria you can set: 

 

 

1. Enter a Patient ID, Session or Sample ID 
fields, or browse for the information using 
the Browse  button. 

 

2. Adjust the date range. Use the drop-down 
calendars in the Session Date
select a different start and end date. 

 fields to 

 

3. Enter or browse for specific sample or 
session characteristics or status (see 
below). 

 

4. Once you set criteria and click the Find
button on the left panel of the 

 
Reports 

of the window filters accordingly. 
window, the session list in the right panel 
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ssaammpplleess  sseelleecctteedd  

SSaammpplleess  

AA  sseessssiioonn  wwiitthh  
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Session/Sample Selection 

 In the Samples/Sessions list, click the  
show its samples. 

sign next to any session to expand the display to 

  

 

 

 

 

 

 

 

 

 

 

 

 

1. Select the check boxes next to each sample you want to include in a report. Select the check 
box next to a session ID to include all of its samples. (Deselect the check box of any sample or 
session you do not want to include in the report.) 

2. If at least one sample has been selected for a session, the Include 

3. (Optional) To view all the samples available, or to view only the samples you have selected so 
far, click the 

cell for that session is 
highlighted with grey. If all samples for a session are selected, there is a check box in the 
Include In cell. 

Samples tab and select or deselect the check box for Show selected samples

4. Alternatively, you can right-click on a session or sample and apply one of the following: 

. 

 

 

 

 

 

 

 Select All:

 

 select all sessions and samples for inclusion in the report. 

Deselect All:

 

 deselect all sessions and samples from inclusion in the report. 

Analysis Select: specify the analysis product report type (Micro SSP, KIR, ConsenSys, 
Quantiples Beads, etc.) 
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EExxaammppllee  ooff  aa  rreeppoorrtt  vviieewweedd  iinn  tthhee  RReeppoorrtt  VViieewweerr  

To create a separate report for each selected sample, select the  

check box next to 1 Sample per Report

View, Print or Export Reports 

. 

 

 Once you have the report type and all the samples selected, click View Report. The report is 
displayed in a separate window, the Report Viewer

 

. 

 

 

 

 

 

 

The Report Viewer contains 
various toolbar buttons to 
allow you to export, print and 
navigate through your report. 
The functionality of these 
buttons is described in the 
following table. 
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 To close the Report Viewer window, click the Close button  in upper right corner of the 
viewer. 

Export Report 

 

1.  Click the Export Report button  when you want to export a report in one of several 
standard formats. The Select Output Directory and Save Type

 

 dialog box is displayed. 

 

 

 

 

 

 

Toolbar Button What it Does 
 Export Report: Exports reports in one of several available 

formats including, Crystal Reports, PDF and Microsoft Word. 

 Print Report: Sends the current report directly to the printer. 

 Toggle Group Tree: Opens a tree panel on the left side of 
the Report Viewer window which lists all the samples 
included in the current report. 

 Report Page Navigator: If the report has multiple pages, 
these buttons allow you to move to the first page, the next 
page, the previous page or the last page. 

 Find Text: Clicking this button opens a text box which allows 
you to search and find text throughout the report. 

 Zoom: Click the down arrow on this button to choose a zoom 
setting, view an entire report page, or view by the report 
page’s width. 
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1. Enter a name for the current exported report, or browse for a report file to export. 

2. Select a format from the Save as type

3. Click the 

 drop-down list, (Excel, Acrobat, Word, or Rich Text 
format). 

OK button. By default, the file is saved in 

4. 

C:\OLI Fusion\data\report. 

You can also export a report by clicking the Export Report  button on the main 
Reports page. 

Accessing Reports from the My Favorite Menu 

 

The My Favorite menu is a convenient way for you to access and generate the reports you use most 
often. You can make as many as 18 report types available from the My Favorite

Adding Reports to My Favorite 

 drop-down, including 
custom reports.  Adding to or deleting from the list is easy. 

 

Make sure you have selected the report you want to add to My Favorite (verify that its name is 
displayed in the Report Options

 Select 

 section of the Reports window). 

My Favorite > Add to My Favorite

 

. 

 

 

 

 

 

The current report name is added to your My Favorite menu. When you want to generate this report, 
just click on its name from the bottom portion of the My Favorite

 

 menu. 

 

 

 

 

Removing Reports from My Favorite 
 

1. Select My Favorite, 

The 

and select the report you want to remove from the list of reports at the 
bottom of the menu. 

My Favorite menu closes. 
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2. Select 
Favorite

My Favorite > Remove from My 

 

. 

 

The report you selected in step 1 is no longer displayed at the bottom of the My Favorite

 

 menu. 
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Report Tools 

Customizing Report Appearance 

Note:  You must be a supervisor-level user in HLA Fusion and have Crystal Report Designer 
software installed on your computer to use this feature. 

This feature allows you to format the appearance of HLA Fusion reports to meet your specific needs. 
For example, you can change font style, size and color as well as the location of text and data fields on 
the report.  

 HLA Fusion automatically launches the report designer if it is installed in the default directory 
(C:\Program Files\Business Objects\BusinessObjects Enterprise 
12.0\win32_x86\crw32.exe

 Use Notepad to open the 

).  

OneLambda.Fusion.Interface.exe  file, located in C:\Program 
Files\One Lambda\HLAFusion\IVD. Make sure that Crystal Report Designer path name is 
entered on the following line of this file (see figure below): 

EEddiittiinngg  
OOnneeLLaammbbddaa..FFuussiioonn..IInntteerrffaaccee..eexxee

<add key="ReportDesigner" 
value="C:\Program Files\Business Objects\BusinessObjects Enterprise 
12.0\win32_x86\crw32.exe"/> 

 

 Please note that all the report files used in HLA Fusion are installed in the directory C:\OLI 
Fusion\rpt, and they all have the extension of .rpt. These files can be moved anywhere for 
central access, but to do so, you must update the OneLambda.Fusion.Interface.exe

 When you open a report to customize it, a backup copy is automatically created with the 
timestamp as the suffix of the report name. This allows you to retrieve the original report 
format, if needed. 

  file 
to reflect the new location (see figure above). 

1.  Select Reports > Tools > Customize Report.  
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Use the Crystal Report Designer tools to modify the appearance of your report. 

Once you have made changes to the report format, save it. Make sure you do not change the name of 
the report file. Next time you run this report in HLA Fusion, the report will have the appearance you 
last saved in Crystal Report Designer.  

Creating Custom Data Export Templates 

 

1.  Select Tools > Setup Data Export

 

 to customize report data export by setting up templates 
that determine the type of report data (session, sample, patient, results, etc.) is exported when 
you select that template. 

The Export Data Setup

 

 dialog box is displayed, allowing you to 
select the name of the export template, the fields to be included, and 
the field order you want for the template. Select check boxes on the 
left to select category and fields. On the right side of the dialog box, 
drag and drop the fields, or hold the CTRL key down and press the 
Up/Down arrow keys to change the order. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. When you are done, click the Save  button.  

The new template is added to available export templates from the Tools > Export Data

 

 menu. 
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EExxppoorrtt  DDaattaa  ––  SSeelleecctt  tteemmppllaattee  

EExxppoorrtt  DDaattaa  ––  ffiillee  ssaavvee  llooccaattiioonn  

 

 

3. When you are ready to export data, first select all the 
sessions you want to include from the available list. 
Then, select Tools > Export Data
templates. The 

, and select one of the 
Export Data

 

 dialog box is displayed. 

 

 
 
 
 
 
 
 
 
 
 
 

4. Select the format for the exported data—XML, CSV or Text. The exported data file is saved by 
default in C:\OLI Fusion\data\export

5. Click the Save 

. 

 button. 

 

Creating Custom Reports 

 

Certain report types allow you to customize the types of fields which are included or excluded. 

Note:  For Molecular Custom reports, you must make sure the Free 3 of 9 Extended  font is 
installed on your computer—otherwise, the barcode will not be recognized. If needed, 
you can download this font for free at http://www.free-barcode-font.com/. 

1. To create a custom report, select a report type containing the word “Custom” in its name, (for 
example, Molecular Custom, under the Generic Typing

2. Click the 

 report type menu).  

Setup

The Custom Query Report Setup window is displayed, allowing you to customize report content by 
selecting from various categories and fields. 

 button in the Report Option section of the window. 

 

http://www.free-barcode-font.com/�
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Custom Molecular and Antibody Report Setup 

 
1. Enter a name or select one from the drop-down list. 

2. Select the check box next to each field you want to include in this report. 

 

Note:  To include all related fields, you can click the Check All

 

 button to select all the fields in 
the category. 

3. Click the Save  button to save the custom report setup you have just selected. 
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SSaammppllee  SSuummmmaarryy  wwiinnddooww  

RReeppoorrttss  ––  SSaammppllee  SSuummmmaarryy  SSccrreeeenn  

Sample Summary 

 

The Sample Summary feature lists multiple samples and their typing results. 

 Select samples using the Reports

 Click the Sample Summary button. The 

 window. 

Sample Summary

 

 window is displayed; it 
contains two tabs— Molecular and Antibody. 

 

 

 

 

 

Molecular Typing Sample Summary 

 

Selected antigen typing records are displayed on the Molecular tab of the Sample Summary screen. 
You can view typing information in a condensed format, as well as display more details for any 
sample. 

1. Select samples using the Reports

2. Click the 

 window. 

Sample Summary button. The default tab is 
Molecular

3. Select an option from the Select Type of Data to Display 

. 

drop-down list. 

(The window displayed depends on the option selected.) 

 

 

 

 

 

 

 

 

 

 

4. Click the Export  button to export the displayed data as an Excel file. 
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 Or, click the DNA  button to export molecular specificities as an Excel file. 

5. Click the Close  button at the upper right corner of the window to close and return to the 
Reports

 

 window. 

Antibody Screening Sample Summary 

 

Any selected antibody screening records are displayed on the Antibody tab of the Sample Summary 
screen. You can view screening information in a condensed format, as well as display more details for 
any sample. 

1. Select samples using the Reports

2. Click the 

 window. 

Sample Summary  button. 

3. Click the Antibody

 

 tab. 

 

 

 

 

 

 

 

 

 

 

Antibody Sample Summary Window 

4. Click the Export  button to export the displayed data as an Excel file.  

5. Click the Close  button at the upper-right of the window to close and return to the main 
Reports

 

 window. 
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View Records 
The View Records feature presents typing results and analysis details for each sample selected. 
Sample information is shown for one sample at a time. From the View Records menu, you can view 
screening and typing records individually. 

1. Select data records using the Reports

2. Click the 

 window. 

View Records  button. 

3. The Data Display screen opens.  Use the Arrow  buttons to navigate through 
samples. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Use the arrow buttons to navigate through samples. 

5. Click the View Analysis  button to open the analysis window for the current 
sample. 

 

The analysis window can be resized. 
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VViieeww  AAnnaallyyssiiss  
DDiissppllaayy

 

Click the Close  button to close the window and return to the main Reports 

 

window. 

Patient Info 

 

You can view patient records associated with selected samples by clicking on the Patient Info tab. 
Patient information can also be viewed by Patient ID using the Patient look up function of the Patient 
Management menu. From the Patient Info

To view patient information, you must select a sample(s). You can view, but not edit the displayed 
information. 

 menu, you can view Patient/Donor records. 

1. Select sessions or samples from the Reports

2. Click the 

 window that have an associated Patient/Donor 
ID. 

Patient Info  button. 

 

The Patient/Donor information screen is displayed. 
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3. Click the Test Info

4. Click the 

 tab to see the information for the current patient/donor. If more than one 
information card is displayed, use the arrow buttons to navigate through the patient records. 

Close  button in the upper right corner to close and return to the Reports

 

 
window. 

Audit Trail Report 

 

You can view and print a report of user activity for the current database. This data is only available if 
you have done the following: 

 Set up and connect to an Audit Trail Log/database, (see the: HLA Fusion Database Utility User 
Manual

 Enabled Audit Logging from the HLA Fusion default home page. 

). 
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AAuuddiitt  TTrraaiill  LLoogg  SSccrreeeenn  

Once you have completed the above and wish to view audit log data, take the following steps: 

 On the home page, click the Reports  tab in the Fusion Explorer, 

 Select 

  Or... 

  

Reports on the Fusion Menu Bar at the top of the screen. 

 At the Reports screen, select Miscellaneous > Audit Trail Log

The Audit Trail Log dialog box displays. 

. 

 

 

 

 

 

 

 

 

 

 

 

 

 Use the drop-down arrow to select the User for whom you want to see database actions. 

 Select the date range and options you want the report to include. 

 

Click the List  button to see the report. If you want to export the Audit Trail Report to Excel, click 
the Export  button

 

. 
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Report Types 
There are several report types available. Although most report types are listed in this section, please 
note that because new reports are sometimes added between updates to this user manual, you may see 
more reports listed in the software. 

Patient

 

 - (all patients in the Fusion database) 

Patient Summary

 

 - (summary of both typing and antibody testing results associated with a 
Patient ID) 

Patient Typing for Batch

 

 - (typing summary report over different loci for a set of samples, 
based on a selected session) 

Patient Custom - (you select the type of patient data to include for the selected samples) 

Generic Typing

 

 - (typing data from analyzed LABType and Micro SSP samples) 

Molecular Custom

 

 - (you select the type of molecular data to include for a set of samples) 

Custom Typing Results by Sample

 

 - (you select the type of molecular data to include for 
selected samples) 

Allele Summary

 

 - (typing report of possible allele pairs and assigned allele code results for a 
set of samples) 

Allele Code

 

 - (typing report of possible allele codes and assigned allele code results for a set 
of samples) 

Molecular Typing Summary

 

 - (typing report of the possible allele code, assigned allele 
code, assigned allele pairs, assigned serology, and other assignments for a set of samples) 

Combined Sample – Generic Typing - (Combines samples from other sessions into one 
report) 

Micro SSP

 

 - (data from analyzed Micro SSP samples) 

Custom SSP Report 

 

– (User-selectable data fields based on Micro SSP analysis) 

SSP Report - (detailed typing report for Micro SSP™ tests that may be customized) 

SSO - 

 KIR Summary Table 

(data from analyzed SSO samples) 

Generic Antibody

 

 - (antibody data from analyzed LABScreen, FlowPRA, LAT or LCT samples) 

Antibody Custom

 

 - (User may customize a report for antibody data for a set of samples) 

Antibody Screening/ID

 

 - (antibody data report that is fixed in format) 

Antibody Screening Results

 

 - (summary table for a selected set of samples which includes 
the overall final results made, %PRA, other assignments, and comments) 
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Specialty

 

 - (reports created for a specialized purpose for specific users) 

Antibody Reaction

 

 - (summary table of computer specificity assignments based on reaction 
scores) 

LBSW

 LBSW v3 

  

 

 

HML V0.2 

 SCORE 

HML V0.3  

 BmT –

 
 ABDR 

Reaction Assignment Report

 
 - (export report including Sample ID and reaction string) 

 
Thai Export 

 
Thai Export v3 

 
Thai Export - LABScreen 

 
UMC-Utrecht Report 

 
KIR HML: v.3 Report 

 
BML 

 ABMDR 

NMDP Code Report 

 CMDP 

 
 

Manzen – LABType 

 
Manzen - LABScreen 

 
LABScreen SA MFI 

 
LABScreen – Australia MFI (Summary and detailed reports) 

 
LABType – Australia 

 
Raw Data Export 

 
Maastricht Export 

 
NIH Export 

 
KIR Export 

 
LAT Export 

 

NKR Report 
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Statistical

 

 - (statistical or aggregate data for trending, measurement, monitoring, etc.) 

Allele Group Frequency

 

 (displays the frequency of allele groups based on the first two 
digits of an allele assignment for selected sessions or the database) 

Allele Group Frequency Extended

 

 - (displays the frequency of allele groups based on NMDP 
code results or allelic level assignment for selected sessions or the database) 

 

Bead Exclusion Report (Bead numbers excluded from an analysis) 

Cut-off Adjustment Summary

 

 (summary of all cut-off changes made for selected sessions 
or based on a specific catalog file) 

 

LABType Control Value (Control values by exon for a given catalog) 

Catalog Statistics (Number of samples analyzed using a specific catalog) 

Miscellaneous

 

 - (reports that do not fall into one of the above categories) 

Database Information

 

 (describes the usage of the current database) 

Batch Data File Summary

 

 (a log of the status of all the sessions run in the system) 

NMDP Code 

 

(list of NMDP codes and their allele definition) 

Serological Equivalent 

 

(list of alleles and their serological equivalent definitions) 

Typing Query

 

 (database search report that lists the samples found for a selected allele) 

 

NMDP Report + Export 

Audit Trail Log (a log with all specified activity for a selected users in the current Fusion 
database) 

My Favorite 

 (Reports listed depend on what you have stored under this menu.) 

- (any of the above reports saved in a favorites list) 

 



One Lambda | User Manual: HLA Fusion™ Research Software 3.0 (FUSREPGRX) 

 
HFR-MAN-v3.x.x-EN-00, Rev 0 137 

 

Data Management 
When you select Data on the Fusion menu bar, a window is displayed that allows you to manage 
session files, as well as create log files of session data. From this menu, you can delete, archive, 
activate, and move sessions to a different database. You can also map the alleles in a session to the new 
nomenclature format. 
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Session Management 

To manage your data at the session level, use the Data option from the HLA Fusion main menu. 
When you select the Data

 

 main menu, the Manage Data window is displayed. 

 

 

 

 

 

 

 

 

Manage Session Data Window 

 

 When you click the Translate Alleles  button

 When you click 

, all final allele pairs and code for the 
selected sessions are converted to the new nomenclature format and stored in the database. 

Move Sessions , you can select another Fusion database into which 
the selected sessions are moved to. 

 

 

 Clicking the Copy Patient  
button, opens the Select Patient screen. 

 

1. Select a patient from the list 
displayed on the Select Patient 
screen. 

2. Click the OK button. 
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The Copy Patients table opens. 

 

 

 

 

 

 

3. Select the patients from the list that you wish to copy by placing a check mark next to the 
Patient’s ID in the Select column. 

4. Click the Browse  button at the bottom of the screen to select the Target database 
where the patient record(s) will be copied. 

If necessary, click the Back  button to return to the previous screen. 

5. Click  to make a copy of the patient’s records in the target database. 

 

Note that copying a patient’s records to another database leaves a copy of those records in the source 
database.   

Moving

HLA Fusion allows you to create session log files of your selected analysis sessions, which you can then 
print or archive. 

 a record deletes the specified record(s) in the source database and adds them to the Target 
database. 

1. Provide all necessary session input information by using the drop-down menus and search 
buttons on the left side of the Data window. 

Once a session is selected, its information is displayed on the right side of the window, the Session 
Info

2. Once you have all information you want to include in the log, click 

 pane, where you can add information. 

Save

Once you have displayed the session log you want, use the 

. 

Print Session Log, Archive, Active and 
Delete

Note:  Samples can also be deleted individually, without the need to delete an entire session. 
The only exception are LABType or Micro SSP samples that have been combined. 

 buttons at the bottom of the window to manage the log. 

HLA Fusion allows you to move patient records. 

1. Select Patient ID as the Sorted Select Level, (top center of the main, Manage Data Menu). 
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2. Click the Move Sessions 
 button at the bottom 

of the screen. 

 

 

The Database Login screen appears. 

 

 

 

3. Login using your Login Name and Password. 

 

 

 

 

The Move Sessions screen opens. 

The database which is listed is the database you are currently using.  
To move session data to another database, click the drop-down arrow 
on the right side of the Database Name field and select the Target, or 
destination database name. 

 

 

4. Click the OK button and Fusion begins the 
data transfer.  

After the session(s) have been successfully transferred 
to the target database, Fusion will display this message. 
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Sample Management 
In HLA Fusion, sample lists are an easy way to input a large list of Sample IDs and other sample 
information into the database for use in analysis sessions. Sample lists may be in .XLS, CSV or .TXT 
file format. From the Sample List Import menu, you can import sample lists or edit sample lists prior 
to importation. 

Note:  Please verify all data you import as HLA Fusion performs minimal data validation upon 
import. 
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Importing Sample Lists 

Sample lists are an easy way to input an extended list of Sample ID’s and other sample information 
into the database for use in analysis sessions. 

1.  From the Main Menu, select Sample > Import Sample List

The Import Sample List window displays. 

.  

  

 

 

 

 

 

 

 

 

 

 

 

 

2. Click the Search Sample List  button. 

3. Browse for the sample list to be imported and click the Open  button

4. Type a name in the 

. 

List ID field, and, if necessary, select a Lab code or Contact ID

5. Confirm sample information and edit if needed.  

 from the 
drop-down list. 

 This symbol  indicates that the Patient ID already exists in the Fusion database. 

6. Click to clear the check boxes of any samples you do not want to import. 

7. Click the Import List 

8. Click 

 button to import the selected sample lists. 

Close

 

 to return to the Main Menu. 
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Information Formats for Sample Lists 
The information inside a sample list that you import in to HLA Fusion must be in one of the following 
formats. 

New packing list format 

This file gives the fields (in this order): 

ShipmentLoc(1 – 13),SampleIDName(0198-0398-0),SampleType(AB, DR or AB/DR), 
TurnaroundTime(14, 21 or 14AB/21DR),DCN (3 digit). 

Example line: 

            1 - 13,0198-0398-0,AB/DR,14AB/21DR,074 
       

Packing list: Old Standard ‘X’ samples 

This file gives the fields (in this order):  

ShipmentLoc,SampleIDName,SampleType (1, 2, 3..., and an 'X' for AB/DR samples),DCN 

             1 - 12,0287-7867-8,X,074 

Example line: 

       

Old packing list format, '11' for AB/DR samples 

This file lists (in this order): 

ShipmentLoc, SampleIDName, SampleType (1, 2, 3..., and an '11' for AB/DR samples), 
DCN 

             1 - 15,0287-0779-2,11,074 

Example line: 

       

Comma-Delimited Format 

Each field is separated by commas. The use of quotes around a field is optional, and is required only if 
the contents of the field use a comma, which could confuse field separation. This file lists (in this 
order):  

ShipmentLoc, SampleIDName, SampleType (AB, DR or AB/DR), TurnaroundTime (14, 21 or 
14AB/21DR), DCN 

"1","12","0287-7867-8","AB/DR","14AB/21DR","074" 

Example line: 
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Tab-Delimited Format 

Each field is separated by a tab. This file lists (in this order):  

ShipmentLoc, SampleIDName, SampleType (AB, DR or AB/DR), TurnaroundTime (14, 21 or 
14AB/21DR), DCN 

1 12 0287-7867-8     AB/DR   14AB/21DR       074 

Example line: 

 

SDF Format 

Each field is separated by commas. This file lists (in this order): 

BoxSlot, DonarID, SampleType (AB, DR or AB/DR), TurnaroundTime (14, 21 or 14AB/21DR), 
DonarCenter 

     1120287-7867-8AB,DR14,21074 

Example line: 

 

Local/Sample/Patient ID Only 

This file is a Microsoft Excel file. This file lists (in this order): 

Row 1:  Column Title “Local” and “Sample” and “Patient” 
Column A:  LocalID  
Column B:  SampleIDName (required) 
Column C:  PatientIDName 
Column D:  Date 
 

Example: 

 

 

 
 
Viewing and Editing Sample Information 

Sample information can be edited, but associated Patient IDs cannot—only new Patient IDs can be 
added. 

1.  On the Main Menu, select Sample > Manage Sample Info

 

. 
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2. Use the filters to find samples and click the View Sample  button. 

Note:  Wildcards can be used in the Sample ID field to widen the results. 

3. Edit sample information. 

 Double-click on a Patient ID to open the Patient/Donor Information screen and 
edit information for that patient/donor. 

Note:  You can rename a sample by modifying the name in the Sample ID field. Sample ID’s are 
listed alphanumerically, with all ID’s beginning with numbers listed first. 

4. Click Save to save. Or, click Delete

5. Click 

 to delete the sample. 

Close

Note:  You cannot delete a sample which is part of a session that has already been analyzed. 

 to return to the Main Menu. 
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Test Lists 
A Test List is a list of Sample IDs that can be used repeatedly to automatically write the Sample IDs 
into a session analysis that can be read by Luminex®

 

. It is a useful tool when you have a group of 
samples to be run on multiple tests. 

With the Test List menu you can: 

 Create new Test Lists 

 View and edit existing Test Lists 

 Delete Test Lists 

 Export Test Lists to a .txt file 

Creating New Test Lists 

 

Test Lists must be created in the order in which the samples are to be analyzed. 

1.  From the Main Menu, select Samples > Manage Test List

  

. 

 

 

 

 

 

 

 

 

 

 

 

 

2. Type in a name for the new test list, (or select a previously created test list) and press the Enter 
 key on your keyboard. 

3. Search for samples to add to the test list using the search fields, and click the Search  
button to view the search results. 

4. Highlight samples, and click the Add  button to add them to the test list. 
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5. Click the Save  button to save the new test list. 

6. Click the Close  button exit this screen and return to the Main Menu. 

Viewing and Editing Existing Test Lists 

 

Test Lists can be viewed or edited at any time. 

1. From the Main Menu, select Manage Samples > Manage Test List

2. Use the drop-down list to select a test list, and click 

. 

Continue

3. Click Delete List to permanently delete the selected test list. 

>>. 

4. Click Close

 

 to return to the Main Menu. 

Deleting Existing Test Lists 

 

Deleting a test list removes the list from the database, but the Sample IDs are not removed or changed 
in the database. 

1. From the Main Menu, select Manage Samples > Manage Test List

2. Use the pull-down menu to select a test list, and click 

. 

Continue

3. Add, remove or move samples as desired. 

>>. 

4. Click Save

5. Click 

 to save the new test list. 

Close

 

 to return to the Main Menu. 

Exporting Test Lists 

 

Test lists can be exported for use outside of HLA Fusion only as a .txt files. 

1. From the Main Menu, select Manage Samples > Manage Test List

2. Use the pull-down menu to select a test list, and click 

. 

Continue

3. Click the 

>>. 

Export

4. If prompted to save the test list before export, click Yes to save and continue. 

  button to export test list details to a .txt file. 

5. Select a location to save the test list and enter a file name for it. 

6. Click Save

7. When prompted to create a Luminex Patient List input, click 

. 

No

8. Click 

. 

Close to close and return to the Main Menu. 
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Patient Information 
HLA Fusion™

Note:  Please verify all data you import as HLA Fusion performs minimal data validation upon 
import. 

 can store patient information and associate Sample IDs with patients and donors. You 
can store all typing and screening information in one location for each patient. 
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IImmppoorrtt  PPaattiieenntt  WWiinnddooww  

Importing Patient/Donor Lists 
After creating a Patient/Donor List, you can import the information into HLA Fusion. 

1.  From the Main Menu, select Patient Info > Import Patient List

The Import Patient window displays. 

.  

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

2. If needed, click the Browse  button to locate the patient list. 

3. Select the check box in the Import
import.  You may also click Select All 

 column for each patient you want to 
 to import an entire patient 

list, or Deselect All  to remove all check marks from from the 
Import column. 

4. Click the Import  button to import the selected patients. 

5. Click the Close  button 

Note:  The HLA Fusion system checks the patient/donor lists you attempt to import to verify 
that all characters contained in the data are supported by Fusion. If your list contains 
unsupported characters, a message is displayed to let you know, and the list is not 
imported. Newly imported patient records display alleles in the new nomenclature 
format. Existing patient records display alleles with the existing allele format.  

to return to the main menu. 
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CClliicckk  ttoo  ddiissppllaayy  aa  lliisstt  ooff  ppaattiieennttss//ddoonnoorrss  iinn  tthhee  FFuussiioonn  ddaattaabbaassee  
wwhhiicchh  yyoouu  ccaann  sseeaarrcchh  tthhrroouugghh  bbyy  uussiinngg  nnuummeerroouuss  ccrriitteerriiaa..  

TToooollss  ttoo  mmaannaaggee  ppaattiieenntt  
aanndd  ddoonnoorr  iinnffoorrmmaattiioonn..  

CCoonnvveerrttss  aassssiiggnneedd  aalllleellee  ccooddee  aanndd  
ppaaiirrss  ttoo  tthhee  nneeww  nnoommeennccllaattuurree  
ffoorrmmaatt  aanndd  ssttoorreess  tthhiiss  iinnffoorrmmaattiioonn  
iinn  tthhee  FFuussiioonn  ddaattaabbaassee..  

AAfftteerr  sseelleeccttiinngg  
aa  ppaattiieenntt  oorr  

ddoonnoorr,,  ppllaaccee  
aa  cchheecckk  mmaarrkk  

hheerree  ttoo  eeddiitt  
tthhee  iinnffoorrmmaattiioonn  

ffiieellddss..  

Managing Patient/Donor Records 
The Patient/Donor Management menu allows you to manage one record at a time. 

From the Patient/Donor Management menu you can: 

 Add new patient/donor records 

 Search existing patient/donor records 

 Edit patient/donor records 

 Associate patient/donor IDs with Sample IDs 

 Associate patient and donor records 

 Assign a donor to the Donor PRA 

 Print, export and archive patient records 

Adding New Patient/Donor Records 

 

You can add patient information using the Patient/Donor Information menu.  This is the best option 
for adding a small number of patient records. 

1.  From the Main Menu, select Patient Info >> Manage Patient

 

. 
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2. Enter an ID in the Patient/Donor

 Or click the Browse 

 field. The ID can be alphanumeric, (contain letters 
and/or numbers). 

 button which opens the Patient/Donor List from which 
you can search

3. Enter patient/donor information as needed. 

 and select a patient/donor. 

Fields with an asterisk (*) are required. 

4. Click the Add New  button to save the data and add the patient/donor information 
to the Fusion database. 

5. Click the Close  button to close and return to the main menu. 

 

Lookup Patient/Donor Records 

 

This option allows you to browse through records or search for specific ones. 

If you know the Patient or Donor ID: 

1. Enter the Patient/Donor ID in the Patient or Donor ID field. 

 

2. Click the Enter  key on your 
keyboard. 

 

 

If you know only part of a patient or donor’s information, (first name, last name, etc.): 

1. From the Main Menu, select Patient Info > Manage Patient

2. Click the Browse 

. 

 button which opens the Patient/Donor List. 

 

 

 

 

 

 

 

3. Enter your search criteria, (i.e., patient or donor, last name, etc.) and click the Search  
button. 

4. If the patient/donor is located, place a check mark in the box next to the patient/donor. 

5. Click the Close  button. 
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Editing Patient/Donor Records 

Note:  You must be a Supervisor in order to edit a patient/donor record. 

All patient/donor information, (except patient/donor ID) can be edited. 

1. From the Main Menu, select Patient Info > Manage Patient

2. Enter a Patient or Donor ID, or search by using the steps outlined above. 

. 

 

3. Place a check mark in the Edit/Update check box at the bottom, 
left of the screen. 

 

4. Edit patient/donor information on either of the three 
tabbed forms which are part of this screen.  

(Fields marked with an asterisk (*) are required.) 

 

5. Click the Save  button to store your changes. 

6. Click the Close  button to return to the previous screen. 

Associating a Patient/Donor ID with Sample ID’s 

 

A Sample ID cannot be associated with more than one patient or donor record, but a patient or donor 
record can have more than one Sample ID associated with it. 

From the HLA Fusion Main Menu, select Patient Info > Manage Patient

1. Select a Patient or Donor ID from the drop-down ID box on the main Patient/Donor 
Information screen. 

. 

 

 

 Or, click the Search Patient/Donor 

 button to locate the correct 
Patient or Donor ID. 

 

 

 

2.  Click the HLA Tests tab at the top of the window. 
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PPaattiieenntt//DDoonnoorr  IInnffoorrmmaattiioonn  SSccrreeeenn  ––  HHLLAA  TTeessttss  TTaabb  

 
The HLA Tests screen opens: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

3. Place a check mark next to Edit at the top of the screen to allow changes to be made to the 
record(s). 

 

 

 

 

 

 

 

 

4. Select a Patient or Donor ID. 

5. Click the Associate Sample IDs

6. In the 

 button. 

Patient/Donor Sample Association window, highlight a Sample ID and click the 
arrow  button to add it to the Patient/Donor Sample List. (Click  to remove a 
highlighted Sample ID from the list.) 
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7. Click OK

8. Click the 

 to associate the Sample ID’s and return to the patient record . 

Close  button, or the Exit  button to return to the previous HLA Fusion 
menu. 

 

Translating Associated Patient/Donor Results to New Allele Code 

 

Patient or Donor results can be translated to update the allele code names to the new NMDP allele 
code format. 

The new format will affect allele code and allele pairs assigned to the selected patient/donor, and will 
be stored in the Fusion database in the new format. 

1. On the HLA Fusion menu bar, select Patient Info > Manage Patient

2. Select a patient/donor record. 

. 

3. Click the Translate Alleles  button

4. Click the 

. 

Save  button to save your data. 

5. Click the Close  button, or the Exit  button to return to the previous window. 

 

Associating Patient and Donor Records 

 

A Patient ID can be associated with more than one donor record, and a donor ID can have more than 
one patient record associated with it. 

1. From the Main Menu, select Patient Info > Manage Patient. 



One Lambda | User Manual: HLA Fusion™ Research Software 3.0 (FUSREPGRX) 

 
HFR-MAN-v3.x.x-EN-00, Rev 0 155 

 

2. Select a patient/donor record. 

3. Click/Select the HLA Tests

4. Place a check mark next to Edit at the top of the screen to allow changes to be made to the 
record(s). 

 tab. 

5. Click the Associate Donor IDs  button. 

6. In the 
Association 

Patient/Donor Sample 

opens, highlight a Donor ID and 
window which 

click  to add it to the 
Patient/Donor Sample List
(Click 

. 
 to remove a 

highlighted Donor ID from the 
list.) 

7. Click Save

8. Click 

 to store the data. 

OK
record. 

 to return to patient 

9. Click Close
previous menu. 

 to return to the 

Associating a Donor with Donor PRA Results 

 

A Donor ID can be included in the calculation for Donor PRA percentage for the antigen products. 

1. From the Main Menu, select Patient Info > Manage Patient

2. Select a donor, or create a new one. 

. 

3. Make sure the Patient/Donor field is set to Donor

Located at the bottom, right of the Patient/Donor Information screen is the Donor Info 
section. 

. 

4. Select the Include in Donor PRA

5. Select the Donor Type from the drop-down selection. 

 check box. 

 

 

6. Click the Browse Button  to open the 
Donor Group Selection screen and choose the 
appropriate donor group(s). 

7. Click the OK  button to return to the 
Patient/Donor Information screen. 
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Printing Patient/Donor Records 

 

HLA Fusion prints both Record Management tabs regardless of which tab is currently being viewed. 

1. From the Main Menu, select Patient Info > Manage Patient

2. Select a patient/donor record. 

. 

3. Click Print

4. Click 

 to print. 

Close

Exporting Patient/Donor Records 

 to return to the Main Menu. 

 

Patient/donor records can be exported individually to a CSV file. The file has the same format as a 
Patient List. 

1. From the Main Menu, select Patient Info > Manage Patient

2. Select a patient/donor record. 

. 

3. Click Export

4. Select a location to save the CSV file to and enter a file name.  

 to export. 

5. Click Save

6. Click 

. 

Close

 

 to return to the Main Menu. 

Archiving Patient/Donor Records 

 

Archived patient/donor records are not available for reporting or associating. You can still view 
archived records and reactivate them by clearing the archive check box. 

1. From the HLA Fusion Menu bar, select Patient Info

2. Click the 

 > Manage Patient. 

General Info

3. Select a patient/donor record. 

 tab. 

4. From the Patient/Donor List window, select Archive from the drop-down Active/Archive

5. Click 

 
list. 

Save

6. Click 

 to save. 

Close to 

 

return to the Main Menu. 
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Deleting Patient/Donor Records 

 

Patient/donor records can be deleted through the Manage Patient menu option. 

1. From the Main Menu, select Patient Info > Manage Patient

2. Click the 

. 

General Info

3. Select a patient/donor record. 

 tab. 

4. Click Delete

5. Click 

 to delete the patient/donor record from the Fusion database. 

Save

 

. 

Creating Patient/Donor Lists 

 

The following is an example of a patient list that can be created and the guidelines for doing so. The 
patient list must be formatted for import via a program like Excel or Notepad and saved as a 
Windows compatible CSV file. 

The first field/section must contain the names of the patient list fields, each separated by commas. 

Note:  Creating a new patient list can be made easier by first exporting an existing list into CSV 
format, and using the fields in that to build your new list. 

Patient List Field Names and 
Format

PatientIDName,CategoryGrp,FamilyID,FirstName,MiddleName,LastName,Ssn,Dob,Gender,Ethni
city,Address,City,State,Region,Country,ZipCode,Email,Phone,WkPhone,Cellular,Fax,Emplo
yer,SpouseName,SpouseBloodType,EmergencyContact,EmrgncyTel,DCN,HospitalName,Division,
BloodType,Disease,RhBloodType,PatientDonorFlg,Associated SampleIDs,Associated
DonorIDs,HLA1_A,HLA2_A,HLA1_B,HLA2_B,HLA1_BW,HLA2_BW,HLA1_C,HLA2_C,HLA1_DRB1,HLA2_DRB
1,HLA1_DRB3,HLA2_DRB3,HLA1_DRB4,HLA2_DRB4,HLA1_DRB5,HLA2_DRB5,HLA1_DQB1,HLA2_DQB1,HLA
1_DQA1,HLA2_DQA1,HLA1_DPB1,HLA2_DPB1,HLA3,HLA1_DRB4,HLA2_DRB4,HLA1_DRB5,HLA2_DRB5,HLA
1_DQB1,HLA2_DQB1,HLA1_DQA1,HLA2_DQA1,HLA1_DPB1,HLA2_DPB1,HLA1_DPA1,HLA2_DPA1,HLA1_MIC
A,HLA2_MICA,HLA1_MICB,HLA2_MICB,HLA_KIR,ClassI_AbSpec,ClassII_AbSpec,MIC_AbSpec,Unacc
eptableAntigens,AcceptableAntigens,Notes,SHLA1_A,SHLA2_A,SHLA1_B,SHLA2_B,SHLA1_Cw,SHL
A2_Cw,SHLA1_DR,SHLA2_DR,SHLA1_DR345,SHLA2_DR345,SHLA1_DQ,SHLA2_DQ,SHLA1_DP,SHLA2_DP,D
onorType,IncludeInDonorPRA

 

Subsequent lines must list the actual patient information, alphanumerically, (can be letters and/or 
numbers) separated by commas.  If there is no information for the patient in a particular field, that 
field still requires a comma as a placeholder. 

Note:  For all manual serology entries, the locus must precede the value. For example, for an 
A locus of value 23, you must enter A23

 

. 
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EExxaammppllee  PPaattiieenntt//DDoonnoorr  LLiisstt  
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PPaattiieenntt  AAnnttiibbooddyy  TTrraacckkiinngg  wwiinnddooww  

CClliicckkiinngg  tthhee  SSaavvee  
bbuuttttoonn  hheerree  ssaavveess  
aannyy  ssaammpplleess  lliisstteedd  

iinn  tthhiiss  aarreeaa  ffoorr  
  ffuuttuurree  aannaallyyssiiss  aass  

ssaammpplleess  wwiitthhiinn  tthhee  
cchhoosseenn  ddaattee  rraannggee..  

Patient Antibody Tracking 
You can track antibody strength for each patient over a period of time. The information tracked is 
taken from the typing data stored in their Patient/Donor Info card and the antibody data in their 
analysis samples (LABScreen Single Antigen and LABScreen Singles) for the specified date range. Take 
the following steps to display graphs and data that track a patient’s antibody data. 

Make sure you have patient and donor information entered into HLA Fusion. If not, you can import it 
from a patient list and/or manually enter the data on the Test Info

1. Select 

 tab of the Patient/Donor Info 
card. Patient and donor records must be associated. 

Patient Info > Ab Tracking

The Patient Antibody Tracking window is displayed. 

. 

 

 

 

 

 

 

 

 

2. Click the drop down arrow next to the Patient ID

3. The Molecular and Serological Typing fields are automatically filled with available data for the 
specified patient. 

 field to select from a list of patients stored 
in your Fusion database. Or click Search and search by Patient ID, First or Last name, etc.  

4. Select the start and end date range from which you want to view sample antigen data for this 
patient, (click the drop down arrows in the date fields to display a calendar). 

5. You can select Secondary Ab (IgG, IgM, C1Q, All) or enter one of your own. This is a way to 
filter samples and it means that samples you want to bring up must have this secondary Ab. 
Otherwise, they will not be available when Find is clicked. 

 (Optional) You can display the percentage of PRA from available donors in the system or 
from selected donor groups who match the computer-assigned antibodies for the current 
sample. 
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DDoonnoorr  GGrroouupp  SSeelleeccttiioonn  

FFiinndd  PPaattiieenntt  LLiisstt  

 
6. Click the Donor PRA button to bring up the following dialog box from which you can select 

donor groups or All Donors.  

The Donor PRA calculation is displayed next to the Donor PRA button. 

 

 

 

 

 

 

 

 

  

7. Click the Find

 

 button to display a list of samples for this patient that are within the specified 
date range. 

 

 

 

 

 

 

 

 

 

 

 

Note:  To add final assignments to a sample, double-click in the Final Assignment

8. Select the check box in the 

 column for 
the sample to display the analysis window and add the assignment. Also, only samples 
with a date can be included in this tracking. If the Sample Date column is empty for a 
sample, click on the empty Sample Date cell and use the pull-down date-finder to add a 
date. 

Include

 

 column for the sample(s) you want to include in the Ab 
tracking graphs and data. 



One Lambda | User Manual: HLA Fusion™ Research Software 3.0 (FUSREPGRX) 

 
HFR-MAN-v3.x.x-EN-00, Rev 0 161 

IInncclluuddee  AAnnttiiggeenn  LLiisstt  

OOppttiioonnss  
aavvaaiillaabbllee  

iiff  yyoouu  
rriigghhtt--cclliicckk  

oonn  aa  ggrraapphh..  

EExxaammpplleess  
ooff  tthhee  

ggrraapphhss  
tthhaatt  ccaann  bbee  

ddiissppllaayyeedd  
wwiitthh  AAbb  

TTrraacckkiinngg  

SSaammpplleess  

MMoolleeccuullaarr  
  SSeerroo  
  DDaattee  
  

 

The graphs are displayed, (to display a specific type of graph, click on the associated tab). 

9. Select the check box for the antigen(s) you want to include in the tracking. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

10. Select the formula to use for the graphs by clicking the drop down arrow in the Formula

You can double-click on a graph to expand it, and there are right-click options available from each 

graph, (see graphic above). You can also use the expand/contract buttons 

 
field, (Default versus Raw). The formula can also be changed after the graphs are displayed if 
you want to compare the tracking with different formulas. 

 at the upper right 
corners to expand the graphs. 

 (Optional

 (Optional) Enter a numeric value in the User-defined cut-off field. If you want to track the 
antibody signal strength with or without the cut-off applied, select or deselect the check box 
next to User-defined cut-off. 

) You can add donor data, if desired, by using the drop-down arrow next to the 
Donor ID field to select from a list of donors associated with the selected patient. You can also 
create a new donor on the fly by typing a unique name into the Donor ID field and filling in 
the molecular and sero typing. 
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LLiisstt  aannttiiggeennss  
nnoott  tteesstteedd  
wwiitthh  OOLLII  
  tteesstt  kkiittss..  

SSeelleecctt  ttoo  ttrraacckk  
ddoonnoorr--ssppeecciiffiicc  

aannttiiggeennss..  

DDoonnoorr  IIDD  ddrroopp--ddoowwnn  lliisstt..  

SSeelleecctt  ttoo  
iinncclluuddee    
CCllaassss  IIII  
ttrraacckkiinngg..  

DDoonnoorr  AAnnttiibbooddyy  IInnffoorrmmaattiioonn  

PPaattiieenntt  AAnnttiiggeenn  SSiiggnnaall  DDaattaa  ttaabbllee  

 

 (Optional) Select the check box next to Track DSA

Various other Ab tracking graphs are available by clicking any of these tabs: 

 to track donor specific antigens. If this is 
selected and there are donor-specific antigens that are not tested with OLI product kits, these 
are listed. 

 

 

 

 

 

 

 
 

 
 
 

 
 
 
 
 
 
 
 
 

 (Optional) Select the DQA/DPA check box to include these in Class II tracking. 

 (Optional) Manually enter the donor typing in the Sero Typing

11. Click the 

 field. 

Data Table

 

 button to display a raw data table CSV file with the patient antigen 
signal over a period of time. The table can be printed or exported. 
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Profile Management 
HLA Fusion™ tracks all changes to analysis data made by users and allows added data security with a 
two level analysis result confirmation (Save and Confirm). HLA Fusion also stores general laboratory 
information to be used on reports including multiple contract lab codes. 
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User Management 

From the Profile main menu you can: 

 Add new users 

 Edit existing user profiles 

 Change passwords 

 Reset passwords 

 Archive users 

 

HLA Fusion uses two user levels for added security and control of typing and screening results. 

 

A Supervisor can... A Lab Technician can... 

Modify all product configuration settings 
Modify all product configuration settings—except to 
enable Auto Accept All and Computer Generated 
Serology for LABType and Micro SSP products 

Save and Confirm analysis results Analyze data and save analysis results 

Update reference files, such as catalogs 
and NMDP codes 

(Only if authorized by the supervisor) - Update reference 
files, such as catalogs and NMDP codes 

Archive catalogs Archive catalogs 

Modify and delete session and sample 
data 

(Only if authorized by the supervisor) - Modify and delete 
session and sample data 

Modify own & other user accounts Modify own account only 

Change the Lab Profile Manage sample and patient information 

TTyyppeess  ooff  UUsseerr  PPrriivviilleeggeess    
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Viewing the User List 

 

The List User option displays a list of all users currently in the database, both active and retired. You 
can look up and select user profiles. 

1. From the Main Menu, select Profile > List User

2. Type in a name and click Sear

. 

ch

3. Double-click to the left of a user entry to view the profile. 

 to search for current users. 

4. Click Close

 

 to return to the main menu. 

Adding New Users 

 

Supervisors can add new supervisor or technician level users. Technicians cannot add new users. 
Fields marked with an (*) are required. 

1. From the Main Menu, select Profile > List User

2. Click 

. 

Add User

3. Enter new user information. 

 to add a new user. 

4. Select the Active check box under the Role field to activate the user account. 

Note:  If this is a lab tech profile and you want to allow reference file update and/or data 
management privileges for this user, select the appropriate check boxes. 

5. Click Save to save the new user information and return to the main menu, or click Close

 

 to 
discard changes and return to the main menu without saving. 

Editing User Profiles 

 

Supervisors can edit the user profile of any user. Technicians can only edit their own profiles. Fields 
marked with an asterisk (*) are required. 

1. To edit your own profile, select Profile > My Profile

2. To select from a list of users to edit, select 

. 

Profile > List User

3. Edit user information. 

 and double-click to the left of a 
user to select that profile. 

4. Click Save

or  

 to save user information and return to the Main Menu. 

5. Click Close to discard changes and return to the Main Menu without saving. 
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Changing Passwords 

 

Supervisors can change passwords for any user, but they must have the user’s old password. 
Technicians can change only their own passwords. 

1. From the Main Menu, select Profile > My Profile

2. In the user profile, click the Change Password button. 

. 

3. Enter the current and new passwords. 

4. Click the Save Password button to change the password. Or, click Close

 

 to close and return 
to the main menu without changing the password. 

Resetting Passwords 

 

If a user loses or forgets their password, HLA Fusion can reset the password. The new password is the 
same as the user’s user name. Only Supervisors can reset a user’s password. 

1. From the Main Menu, select Profile> List User

2. In the user profile, click the Reset Password button. 

 and select a user. 

3. Click Close 

 

to return to the main menu. 

Changing User Privileges 

 

Only Supervisors can modify a user’s privilege level. 

1. From the main menu, select Profile> List User

2. Double-click to the left of a user to open their profile. 

  

3. In the user profile, select the check box next to either Manage Data or Update Reference 
Files, or both, to give the selected user privileges for those activities within the Fusion 
application. 

4. Place a check mark next to Can Email Report if you want to give a user that privilege.  (You 
will need to supply an email address.) 

5. Click Close 

 

to return to the Main Menu. 
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Inactivating Users 

 

Supervisors can inactivate users who are no longer using HLA Fusion. User information is still stored 
in the database, but the user is not able to log into the program. 

1. From the Main Menu, select Profiles > List User

2. Clear the Active check box to deactivate the user. 

 and select a user to edit. 

3. Click Save to save user information and return to the main menu, or click Close 

Note: If a User ID is still associated with analysis records, the User ID cannot be deleted. 

to discard 
changes and return to the Main Menu without saving. 
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LLaabb  PPrrooffiillee  IInnffoorrmmaattiioonn  SSccrreeeenn  

Lab Profile 
The Lab Profile menu displays the contact information for your lab, network information used by HLA 
Fusion, and NMDP contract lab codes. Most of this information is entered during installation, but can 
be updated at any time. Only supervisors can change the Lab Profile. 

From the Lab Profile menu you can: 

 Edit the Lab Profile 

 Add, edit and remove Lab Codes 

 Change the Network Path 

 Change the Email Server Name 

 

 

 

 

 

 

 

 

 

 

 

 

 

Editing the Lab Profile 

 

Laboratory information displays on most reports, and includes contact information for your lab. This 
information is initially entered during installation, and can be edited any time from the Lab Profile 
menu. Fields marked with an asterisk (

1. From the main menu, select 

) are required. 

Profile > Lab Profile

2. Edit lab profile information. 

. 

3. Click Save to save changes and return to the main menu, or click Cancel to return to the main 
menu without saving any changes. 
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Managing Lab Codes 

 

Lab codes are used on NMDP reports to identify contract labs. Multiple lab codes may be entered and 
stored in HLA Fusion. You can select the lab code you wish to use when creating an NMDP report. 
Only the first three digits of a lab Code are used on NMDP reports; lab code descriptions are not 
included on reports. 

1. From the main menu, select Profile > Lab Profile

To add, edit or delete Lab codes: 

. 

 Click Add Lab Code to add a new lab code. Enter information into the new row. 

 Highlight a lab code to be edited. Click Edit Lab Code to edit the lab code. 

2. Edit lab code information. 

3. Highlight a lab code to be deleted. 

4. Click Delete Lab Code to delete the lab code. 

5. Click Save to save changes and return to the main menu, or click Cancel

 

 to discard changes 
and return to the main menu without saving. 
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Utilities 
HLA Fusion™ uses a variety of reference files for data analysis that need to be updated for new 
products, lots and revisions. You can also change many global product settings to customize analysis 
for your lab, and you can modify default system settings to reflect your personal or network file 
system. 

Warning:  Always use the latest reference files for analysis. Otherwise, analysis results may not be accurate. 
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ttrreeee  

Managing Catalog Reference Files 

Catalog reference files contain all of the reaction-specific information needed for analysis, including 
the following: 

 Bead and well specificities 

 QC information 

 Cut-off values 

 Bead and primer information 

Each new lot or revision of a product needs its own catalog file for analysis results to be accurate. 

 

Updating Catalog Files from a Local or Network Drive  

 

Lab supervisors can input new catalog files for use in analysis when new products, lots, or updates 
become available. Catalog files are also available on the One Lambda download site. 

1. From the main or any of the product home pages, click the [Download] link, or from the 
main menu, select Utilities > Update Reference > Update Reference File

The Update Reference File dialog box displays. 

. 
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TThhee  nnuummbbeerr  
ooff  ccaattaallooggss  

ccuurrrreennttllyy  iinn  
yyoouurr  FFuussiioonn  
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nnoott  iinn  yyoouurr  FFuussiioonn  ddaattaabbaassee..  

LLiissttss  aallll  
aavvaaiillaabbllee  ccaattaallooggss  

SSeerroollooggyy  eeqquuiivvaalleenntt  ffiillee  nnoottiiccee  

 

If your serology information is outdated, or you have not imported it yet, a message like the one 
shown below is displayed. If you do not see this type of message, go to the next step. If you see the 
message, click the OK

 

 button to open the Serology Import dialog box. 

 

 

 

 

2. Make sure the Catalog

3. Click the Auto Update 

 option button is selected. 

 button, (only enabled if you’re connected to the Internet). 

The Reference File Manager screen opens. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

In the Show these products section, (bottom left) use 
the radio buttons to easily determine which catalog 
reference files have been updated and decide which ones 
you’d like to import into your HLA Fusion database. 
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TTrraannssllaattee  aalllleelleess  OOppttiioonn  

The Latest Lot or Revision  drop-down is only enabled if you select the 
Updates/Revisions radio button in this section. 

 Fusion updates the number of available recent catalog reference files for products when you 
select either by Latest Lot, Latest Revision, or the default listing of Latest Lot or 
Revision, (which includes both). 

 Clicking the Select All  button places a check mark in the Select Column for all 
product reference files. 

 Clicking the Deselect All  button clears all reference file selections. 

 Click the Get Docs  button to download all associated documents including 
worksheets, probe/primer sheets and data sheets. 

4. Using the file directory tree on the left, choose the catalog files to be imported, or click Select 
All to indicate all files that are listed. 

Note:  To determine which catalog is the most recent one available, HLA Fusion looks first at 
the lot number and then the revision number. A updated lot number gets flagged as the 
most recent version of a catalog, even if there is also an update to the revision number 
of the previous lot since you last downloaded catalogs. 

5. Click the Import  button. 

Note:  If you select Yes or Yes All, the software will translate the old allele format into the 
latest format. For the Molecular products (LABType or Micro SSP), the software will 
drop the old format allele completely if it does not find a matching allele in the new 
format list. For Antibody products, if the software does not find a matching allele in the 
new format, it keeps the old format allele, but adds a colon. 

If you select a catalog to import that is in the old allele format, you are notified with a 
message. Select the translation option you want to use before going to the next step. 

 

 

 
 
 
 
 
 

6. Click Yes, or Yes All to translate the selected catalog files. 

 

Note:  Catalog importation takes a bit longer when alleles are also translated. 
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RReeffeerreennccee  FFiillee  iimmppoorrtt  pprrooggrreessss  

 

 

The results of your reference catalog update are 
noted by Fusion at the bottom, left of the 
Reference File Manager window. 

 

 

6. Click the Close  button to return to the previous Update Reference window. 

Note:  Imported catalog files can be used without restarting Fusion. 

Updating Catalog Files from the One Lambda Download Site 

 

Product catalog files are available on the One Lambda download site 
(http://download.onelambda.com). 

1. From the main or any of the product home pages, click the Download link, or from the main 
menu, select Utilities > Update Reference > Update Reference File

2. Click Auto Update 

. The Update 
Reference File dialog box displays. 

 to open the One Lambda Catalog Updates Selection

3. Select the check box next to the files you want to import. Click the plus or minus signs on the 
file directory tree, to locate the catalog files for each product. You can also click 

 
window. 

Select All or 
Deselect All

4. Click the 

 to select or clear all the check boxes at once. 

Import  button to import the selected catalog files. 

 

 

 

 

 

5. When the confirmation dialog box displays the importation results, click OK

6. Click the 

. 

Close  button

 

. 

Imported catalog files can be used without restarting Fusion. 

 

Note:  You can also click Go to OLI, click the links for the products and catalog files you want to 
import, and follow the download instructions. 
 
If Auto Update does not respond, verify your network connectivity and that the URL you 
set for One Lambda in Utilities > URLs & Paths is correct. 
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FFoollddeerr//  
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UUppddaattiinngg  NNMMDDPP  CCooddee  

Updating Molecular Typing Reference Files 

Reference files contain allele code and serology equivalent information used in analysis. It is 
important to update them regularly for accurate allele code and serology assignments. 

From the Update Reference menu you can download the necessary files: 

 NMDP codes 

 Local codes 

 Serology Equivalent files 

Updating NMDP Codes from a Local or Network drive 

 

The National Marrow Donor Program (NMDP) provides a list of allele codes that can be used in 
molecular typing analysis. If you have a current list stored on your local or network drive, use this 
procedure to import it so HLA Fusion can access it. The most current NMDP code file is available on 
the NMDP download site. 

1.  From the main or any of the product home pages, click the Download link, or from the main 
menu, select Utilities > Update Reference > Update Reference File

The Update Reference File dialog box displays. 

.  

 

 

 

 

 

2. Select the NMDP

 

 option. 
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3. Navigate to the NMDP file on a local or network drive, using the Import Directory

4. Click the Import NMDP 

 tree. 

 button to import the selected file. 

5. Click the Close  button to return to the Update Reference menu. 

 

Updating NMDP Files from the NMDP Website 

 

Follow this procedure to import the NMDP list from the NMDP website: 

1. Click the [Download] link, or from the main menu, select Utilities > Update Reference > 
Update Reference File

2. The Update Reference File dialog box displays. 

. 

3. Select the NMDP

 

 option. 

 

 

 

4. Click Auto Update, which automatically imports the current NMDP file for use with HLA 
Fusion.  

Or, click Go to NMDP

Note:  If Auto Update does not respond, verify your network connectivity and that the URL you 
set for NMDP in 

 and follow the instructions for downloading an NMDP file from the 
website. 

Utilities > URLs & Paths

Creating a Local Code File 

 is correct. 

 

Local code files are created by individual labs; local codes are created to make ambiguous typing 
assignments easier to store and read. For example, ambiguities, such as B*1501/1501N/1502, can be 
condensed with a code to B*15AB for simpler record keeping. 

1. Copy the local code template from the HLA Fusion CD to a local drive. 

2. Use a text editor to edit the template and add code definitions. 

3. Follow the example format, using a Tab to separate each field and a slash ( / )to separate 
multiple values within a field: letter code <tab> numeric allele extension to which the code 
applies 

4. Save the file as 

See the next section, 

local_code.txt 

Updating the Local Code File

 

, to import the file. 
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DDiirreeccttoorryy//  
FFoollddeerr  ttrreeee  

UUppddaattee  RReeffeerreennccee  FFiillee::  LLooccaall  CCooddee  

LLooccaall  CCooddee  
OOppttiioonn  

 

Updating the Local Code File  

 

After a Local Code file has been created, it must to be updated in HLA Fusion. 

1. From the main or any of the product home pages, click the Download link, or from the main 
menu, select Utilities > Update Reference > Update Reference File

The Update Reference File dialog box displays. 

. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Select the Local Code

3. Use the 

 option as shown above. 

import Directory

4. Click Import Local Code 

 Tree to locate and select the Local code file to be imported. 

 to import the selected file(s). 

5. Click Close to return to the Update Reference

 

 menu. 

Updating P Group and G Group Files from the One Lambda Website 

 

The P Group and G Group files, (as published by IMGT)

download.onelambda.com/pub/tray_info/Windows/HLA_Fusion_Catalogs/P_and_G_Group/ 

 can be downloaded from the One Lambda 
download site: 

 
1. From the main or any of the product home pages, click the [Download] link, or from the main 

menu, select Utilities > Update Reference > Update Reference File

 

. 
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UUppddaattee  RReeffeerreennccee  FFiillee::  PP//GG  GGrroouuppiinngg  
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The Update Reference File dialog box displays. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Click the Import P Group  button, or the Import G Group  
buttons. 

 

Updating Serology Equivalent File from One Lambda Website 

 

The Serology Equivalent file can be auto updated from the One Lambda download site 
(http://download.onelambda.com). 

3. From the main or any of the product home pages, click the Download link, or from the main 
menu, select Utilities > Update Reference > Update Reference File

 

. 
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The Update Reference File dialog box displays. 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Select the Serology Equivalent

5. Click Auto Update 

 option. 

 to open the One Lambda Catalog Updates Selection

6. Select the check box next to all files you want to import. 

 
window. 

7. Click Import Serology  to import the selected files. Catalog files are ready for use 
without restarting HLA Fusion. 

8. After the confirmation dialog box displays import results, click Ok

9. Click the Close 

. 

 button. 

 

Note:  If Auto Update does not respond, verify your network connectivity and that the URL you 
set for Serological in Utilities > URLs & Paths is correct. 
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AArrcchhiivvee  CCaattaalloogg  

 

Catalog Management and Information 

Archive Catalogs 

 

You can archive catalog files that are no longer used. The catalog information still exists in the 
database, but is not included in the list of available catalog files for analysis. Catalog files can also be 
restored for use in analysis. 

 

1. From the Main Menu, select Utilities > Update Reference > Catalog 
Information/Management

 

. 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Select the S (select) check box for the catalog files you want to archive, and click the Archive 
 button. 

3. When a pop-up message displays Data Saved, click OK. 

4. Click Close to return to the main menu

Note:  When you import a new version of a catalog file, the system auto-archives the previous 
version. 

. 
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AArrcchhiivveedd  CCaattaallooggss  cchheecckk  bbooxx  

TThhee  lleetttteerr  ““AA””  
iinnddiiccaatteess  tthhaatt  
tthhee  ccaattaalloogg  
hhaass  bbeeeenn  
aarrcchhiivveedd..  

PPllaaccee  aa  cchheecckk  mmaarrkk  hheerree  aanndd  
cclliicckk  tthhee  AArrcchhiivvee  bbuuttttoonn  

ttoo  aarrcchhiivvee  tthhee  ccaattaalloogg..  

PPllaaccee  aa  cchheecckk  mmaarrkk  hheerree  aanndd  
cclliicckk  tthhee  UUnnaarrcchhiivvee  bbuuttttoonn  

ttoo  uunnaarrcchhiivvee  tthhee  ccaattaalloogg..  

AArrcchhiivvee  aanndd  uunnaarrcchhiivvee  ccaattaalloogg  ffiilleess  

Un-Archive Files 

Archived catalog files display an A in the Status column when you view the catalog list and the check 
box for Show Archived Catalogs

 

 is selected. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 In the Archive Catalog window, select the check boxes next to the catalogs you want to 
un-archive, and click Unarchive

 

. 

Viewing Catalog File Information 

 

You can view information about a catalog file and generate a report from the Catalog Information 
menu. Catalog files displayed with an A

1. From the Main Menu, select

 in their Status column have been archived. 

 Utilities > Update Reference > 

2. Click a column header if you want to sort the catalog file list. 

Catalog Management. 

3. Click Report to display a printable, exportable report of the currently displayed catalog 
information. 
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Deleting Catalog File Information 

 

You can delete a catalog file from the Catalog Management menu. Catalog files displayed with an 
A

1. From the Main Menu, select

 in their Status column have been archived. 

 Utilities > Update Reference > 

2. Select the check box next to any catalog you want to delete. 

Catalog 
Information/Management. 

3. Click Delete to remove the catalog information. 

 

Reporting Catalog File Information 

 

You can view and report information about a catalog file and generate a report from the Catalog 
Information

1. From the Main Menu, select

 menu. 

 Utilities > Update Reference > 

2. Click a column header if you want to sort the catalog file list. 

Catalog Management. 

 (Optional) If you want a report in the old format, select the check box next to Old Format 
report. 

3. Click Report to display a printable, exportable report of the currently displayed catalog 
information. 

 

Associating Product Catalog Files and Luminex Templates 

 

You can associate a catalog file with the Luminex template name used for a specific product. HLA 
Fusion automatically associates catalog ID and template names the first time you run the analysis for 
the product. After an association has been made, HLA Fusion automatically selects the catalog file 
associated with the template used in the CSV file when you start analysis. You can also manually add, 
remove, or change associations. 

1. To add or remove an association, select Utilities > Catalog Template Association

2. Add a New Association. 

. 

3. Select a catalog file. 

4. Type in a new template name, or click Browse

5. Remove an Association. 

 to select a Luminex template file (.lxt format) 
to associate with the filename. 

6. Select a catalog file. 

7. Select a template name and click Remove. 



One Lambda | User Manual: HLA Fusion™ Research Software 3.0 (FUSREPGRX) 

 
HFR-MAN-v3.x.x-EN-00, Rev 0 183 

AAlllleellee  ffrreeqquueennccyy  iimmppoorrtt  

 

To modify an Association: 

1. Select a catalog file. 

2. Edit existing template name(s). 

3. Click Save

4. Click 

 to save changes. 

Close 

 

to return to the Main Menu 

Importing Allele Frequency Files (Demographic Frequency) 

 

You can import allele frequency files to use in analysis based on demographics. 

1. From the Main Menu, select Utilities > Update Reference > Demographic/
Frequency. 

Allele 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Select the Create Demographic Group

3. Click the Browse 

 option. 

 button and locate Allele Frequency files. 

4. Click Import. 
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When an Allele Frequency file is successfully imported, the groups it contains are listed in 
Demographic Group and Frequency in Database

5. Click 

. 

Save

Note:  If the header for the column of any allele frequency file you import is empty, the entire 
column is not imported into Fusion, regardless of any other data it contains. If columns 
are duplicated, Fusion gives you an error message and does not import the allele 
frequency file. 

. 

The data contained in the Allele Frequency file may look similar to this graphic. 
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AAlllleellee  ffrreeqquueennccyy  iimmppoorrtt  

Updating Allele Frequency Files (Demographic Frequency) 

 

You can modify allele frequency files before using them in analysis based on demographics. 

1. From the Main Menu, select Utilities > Update Reference > Demographic/

 

Allele 
Frequency. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Select the Update Alleles and Frequency 

3. Click the Browse 

option. 

 button and locate the Allele Frequency file you want to update. 

4. Double-click on the file, or click Open

5. Do any or all of the following to modify the file: 

 in the browser window. 

 Add/delete alleles  

 Delete existing demographics 

 Change the allele frequencies 

 Convert allele format 

6. Click 

7. Click 

Translate Alleles 

Update

8. Click 

. 

Close

 

. 
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CCRREEGG  MMaannaaggeemmeenntt  ssccrreeeenn  

Managing CREG List Information 

 

You can modify existing CREG lists or create new ones for use in PRA and Single Antigen LABScreen, 
FlowPRA, LAT, or LCT analysis. Take the following steps to create or modify a CREG list: 

 

1. Select Utilities > Update Reference > CREG Information Management

 

.  

The CREG Management window displays. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

2. Select an existing CREG group from the CREG Type drop-down list, or Enter a name for a 
new group in the New CREG Type

Do one of the following: 

 field. 

 Enter new or modify existing information in the Group Name and/or Group Detail 
fields and click Save

 Highlight a row of existing group information, and click 

. 

Delete Group

3. When you have completed CREG group creation or modification, click 

. 

Close

Note:  Please verify your data before saving, and please do not mix alleles with the older 
nomenclature format with alleles in the newer format within the same CREG table. 

. 
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Changing Product Configuration Settings 
Changes to product analysis settings apply only to samples not previously analyzed. Previously 
analyzed samples must be re-analyzed for the changes to be applied. 

From the Product Configuration menu you can 

 Change Micro SSP product configuration 

 Change Ab1 filename configuration for SBT analysis 

 Change product settings for LABScreen Mixed analysis 

 Change antibody screening analysis settings 

 Change default negative serum values for LABScreen analysis 
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LLAABBTTyyppee  aanndd  MMiiccrroo  SSSSPP  CCoonnffiigguurraattiioonn  sseettttiinnggss  

Changing Molecular Product Configuration 

 

Changes to LABType and Micro SSP analysis settings apply only to samples that have not yet been 
saved or confirmed. To change analysis settings for previously saved or confirmed samples, you must 
change the settings from the product analysis window and re-analyze the sample. 

 

1. From the LABType or Micro SSP home page click Edit, or select Utilities > Molecular 
Product Configuration > Molecular Analysis Configuration

2. Select either 

 from the HLA Fusion 
main menu. 

LABType or Micro SSP

 

 from the Product Type drop-down menu. 

 

 

 

 

 

 

 

 

 

 

 

 

3. Change configuration values as needed. 

 

 Save Force 1 Pairs

 

 stores force 1 pairs in the database during analysis. The Force 1 pairs 
are also displayed in reports that contain this information. 

Allow Auto-Accept All can only be selected by someone with Supervisor user privileges

 

, 
and allows you to select a button on LABType session summary to accept the batch analysis 
results for all samples. 

Computer-Assigned Serology can only be selected by someone with Supervisor user 
privileges

 

, and automatically populates LABType and Micro SSP analysis serology 
assignment fields, as well as stores results in the database. If this is selected, a warning 
message displays as a reminder that the assignments are estimates, and should not be 
accepted without verification. 
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4. Click the OK  button to acknowledge the cautionary message. 

5. Click Save 

6. Click 

 to save your changes. 

Close  to return to the Update Reference menu. 

 

P and G Code Configuration for LABType 

 

P and G code definition downloads are similar to NMDP.  They can be imported from files or by using 
Auto Update. 

 

You can use the LABType Analysis Configuration screen to 
choose which code you want to use for all your LABType sessions 
to be imported. 

 

 

 

 

 

 

 

 

 

If you’ve selected P or G code on the LABType 
Analysis Configuration screen, you can re-apply the 
code set, (or an updated code set) to a particular 
session on the Session Summary screen by clicking the 
Apply P/G Code button located at the bottom, right 
of the screen. 
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You can also apply P or G grouping by clicking the Set 
Config  button during LABType analysis and selecting either 
P or G grouping from the drop-down list. 

 

 

 

 

Changing Antibody Product Configuration 

 

 

To globally change the antibody 
configuration for any product: 

1. Select 
Product Configuration > Set 

Utilities > Antibody 

Analysis Configuration. 

2. 
Product Type drop-down. 
Select a Product type from the 

 

Note that antibody configuration settings are 
different for each product. 

 

3. Click the Save  button to store 
your configuration settings. 

You may also click the Reset to OLI 
 button to restore the antibody 

configuration to the One Lambda default 
settings. 
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Creating a Combined LABScreen Session Catalog  

 

To run a Class I and Class II combined LABScreen analysis session, create a combined catalog to use 
for your session. You must use a Class I catalog file and a Class II catalog file that have the same 
positive and negative control beads, but do not have any other beads in common. 

1. Select Utilities > Antibody Product Configuration

2. Click Create Combined Products to open the Combined Products menu. 

 from the HLA Fusion main menu. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. Select the first product catalog to be combined and click . 

4. Select the second product catalog to combine and click . 

The new catalog file name appears at the bottom of the selection menu.  

5. Click Save  to save the new combined catalog file for use in LABScreen analysis. 

 Optional: Click Clear

6. Click the 

 to reset the selections and start over. 

Close  button to exit

 

. 
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Changing LABScreen Default Negative Serum Control Value  

 

Negative control sera can be adjusted or added for each product or lot. You can change the trimmed 
mean fluorescence value for each bead individually. 

1. Select Utilities > Antibody Product Configuration

2. Click 

 from the HLA Fusion main menu. 

Set Default Negative Value

 

 to open the Default Negative Serum Value screen. 

3. Select a catalog file, (Catalog ID). 

4. Select an existing Negative Serum value from the 
Select NS drop-down, 

     or 

Select Add New NS Name
menu to create a new negative serum.  

 from the pull-down 

5. Type a name for the new negative serum into the 
Current NS field. 

6. Edit Default NS values for the desired beads in the 
right column. 

7. Click the Save  button to store the changes. 

8. Click the Close  button

 

. 

 

 

 

 

Changing the LABScreen Mixed Product Configuration 

 

You can change LABScreen Mixed analysis positive and negative threshold settings for each product or 
lot. The new cut-off threshold values are used in every analysis session for that product or lot. 

 

1. From the LABScreen home page click Edit, or select Utilities > Antibody Product 
Configuration

2. Click Set Mixed Product Configuration to open the LABScreen Mixed Configuration 
menu. 

 from the HLA Fusion main menu. 
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3. Select a product catalog from the Catalog ID
list. 

 drop-down 

4. Edit threshold values. For LABScreen Mixed catalogs, the 
threshold values can be set at the bead level. 

5. Click Save 

6. Click 

 to save the new values. 

 Close

 

. 

 

 

 

 

 

 

Importing NS Files 

 

Negative Serum (NS) files can be imported to be 
referenced during analysis. 

1. From the Main Menu, select 
Antibody Product Configuration > 

Utilities > 

NS File Import

2. Click the Browse 

. 

 button to locate and 
select NS files. 

3. Click Import NS File

When an NS file is successfully imported, it 
is listed in 

. 

Existing NS Files

4. Click the 

. 

Close  button to return to 
the Update Reference menu. 
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Choosing General Settings 
You can set a number of general system settings, including printer defaults and URLs and Paths. 

1. Select Utilities > General Settings

The General Settings dialog box is displayed. 

 from the HLA Fusion main menu.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2. Use the drop-down menus, or select check boxes to make your selections on this dialog box. 

3. When you have made all of your selections, click Save. 

 

Printer Defaults 

 

From the Printer Setup tab on the General Settings dialog box, you can select settings such as default 
printer and paper size, which will be in place when you print reports or do a print screen. 

1. Select Utilities > General Settings, and click the Printer Setup tab. 

 

FFuussiioonn  GGeenneerraall  SSeettttiinnggss  
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2. Select from the following options for both the Print Screen and Print Report

 If you want to see a print preview or print report dialog each time you print, make sure the 

 panels of the 
dialog box: 

Yes

 If you do not want to select a printer each time you print, select the default printer and 
paper size from the drop-down menus. 

 option is selected. Otherwise, select No. 

Note:  This default printer configuration may be overwritten by the specific page properties of 
certain reports. 

3. Click Save. 

 

Setting HLA Fusion Default URLs and Directory Paths 

 

The URLs & Paths

1. Click [

 option under the General Settings menu allows you to set the default URLs for 
OLI and NMDP websites to download reference and catalog files, and product updates. This option 
also allows you to set the directory path where HLA Fusion, by default, stores catalogs, session/batch 
files, reports, etc. Modifying URLs or paths ahead of time allows you to avoid having to browse for 
files each time you need them. 

Edit] on the right side of the General Configuration panel of the HLA Fusion default 
home page, or select Utilities > General Settings

2. Select the URLs tab, or the Paths tab. 

 from the HLA Fusion main menu. 
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3. Enter a URL and verify that it’s correct by clicking the Browse  button. 

4. For paths, use the Browse  button to locate the directory you want to use for the specified 
purpose, (i.e., where you want to store reports when they are generated). 

5. Click the Save 

 

 Button to store your preferences. 

Activating Products 

 

The Products Selection option on the Utilities menu allows you to activate or de-activate the various 
OLI analysis products that may be used with HLA Fusion. 

1. From the Main Menu, select Utilities > Products Selection

 

. 

 

 

 

 

 

 

 

 

 

 

2. Select or clear the check box next to the product(s) you wish to activate or de-activate. 

3. Click the OK  button. 
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Software Validation 
The HLA Fusion software has functionality to help with the validation process required by Labs, 
Clinics, and hospitals seeking to comply with GCP, GLP and GMP. Validation of the HLA Fusion 
software for your lab environment for regulatory or performance reasons, can be automated by using 
the IQ (Installation Qualification) option from the Utilities > Validation menu. Your lab may 
choose to run these as a standard regulatory validation process, to help troubleshoot issues, or to 
provide information to prepare for a software upgrade. 

 

IQ (Installation Qualification) 

The IQ process assists you with installation qualification of HLA Fusion software by providing a built-
in function. Once the Installation qualification completes, a results report is generated, which you can 
save, print or export to Excel. 

Note:  If your IQ results concern you, export them to an Excel file and e-mail the file to OLI 
customer support. 

1. From the Main Menu, select Utilities > Validation > IQ

The validation test runs. When it is complete, a report is displayed, with the following categories of 
data: 

. 

 Systems Information (e.g., operating system) 

 Environment (e.g., directory path where the HLA Fusion program files are stored) 

 URLs (e.g., the URL for the catalog download site) 

 Database Information (e.g., name of the database) 

 Number and types of files installed (e.g., dll) 

 Lab Information (e.g., name and address of your lab) 

 Analysis Configuration for each product (e.g., low bead count for LABType) 

 

2. Choose to save the report, preview it, print it, or export it to Excel. 
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